MICROSTAR

User Manual

Part Number: M86-E00086
Publication date: May 2006
This document covers the MICROSTAR Rotating Anode Generator.

References to this document should be shown as M86-Exx086 MICROSTAR User Manual.

© 2006 Bruker AXS Inc., 5465 East Cheryl Parkway, Madison, WI 53711. All world rights reserved.

Notice

The information in this publication is provided for reference only. All information contained in this publication is believed to be correct and complete. Bruker AXS Inc. shall not be liable for errors contained herein, nor for incidental or consequential damages in conjunction with the furnishing, performance, or use of this material. All product specifications, as well as the information contained in this publication, are subject to change without notice.

This publication may contain or reference information and products protected by copyrights or patents and does not convey any license under the patent rights of Bruker AXS Inc. nor the rights of others. Bruker AXS Inc. does not assume any liabilities arising out of any infringements of patents or other rights of third parties. Bruker AXS Inc. makes no warranty of any kind with regard to this material, including but not limited to the implied warranties of merchantability and fitness for a particular purpose.

No part of this publication may be stored in a retrieval system, transmitted, or reproduced in any way, including but not limited to photocopy, photography, magnetic, or other record without prior written permission of Bruker AXS Inc.

Address comments to: Technical Publications Department
Bruker AXS Inc.
5465 East Cheryl Parkway
Madison, Wisconsin 53711-5373
USA

All trademarks and registered trademarks are the sole property of their respective owners.

Printed in the U.S.A.

Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>May 2006</td>
<td>Original release.</td>
</tr>
</tbody>
</table>
# Table of Contents

1 About This User Manual .......................................................... 1-1
  1.1 The MICROSTAR Rotating Anode Generator .......................... 1-1
  1.2 Terms and Conventions Used in this User Manual .................. 1-2
    1.2.1 Typographical Conventions ...................................... 1-2
    1.2.2 Equivalent Terms .................................................. 1-2
    1.2.3 Warnings, Cautions, and Notes .................................. 1-3
  1.3 Referenced Documentation .................................................. 1-3
  1.4 X-ray Safety ........................................................................... 1-4
  1.5 MICROSTAR Help and Technical Support ............................... 1-4
    1.5.1 Technical Information on the Web ................................. 1-4
    1.5.2 Technical Support ...................................................... 1-5

2 Safety Considerations ............................................................. 2-1
  2.1 Safety Features ....................................................................... 2-2
    2.1.1 Generator Safety Key .................................................. 2-2
    2.1.2 Radiation Safety Enclosure ......................................... 2-2
    2.1.3 Generator Emergency Switch ....................................... 2-2
    2.1.4 External X-ray ON Lamp ............................................. 2-3
  2.2 Safety Interlocks ..................................................................... 2-3
    2.2.1 Radiation Safety Enclosure ......................................... 2-3
    2.2.2 “X-ray ON” Indicator .................................................. 2-3
    2.2.3 “Shutter Enable” Key ................................................... 2-4
    2.2.4 “Open Beam” Key ....................................................... 2-4
    2.2.5 “Open Beam” Lamp ..................................................... 2-4
    2.2.6 Shutter Bayonet .......................................................... 2-4
    2.2.7 Tube Cover Safety Switches ....................................... 2-4
  2.3 Enclosure Status and its Effect on X-rays and Shutter Operation ... 2-5
    2.3.1 Safety Interlock Panel .................................................. 2-5
  2.4 Potential Hazards ..................................................................... 2-6
    2.4.1 Beryllium ................................................................. 2-6
# Table of Contents

2.4.2 Electrical Safety ................................................. 2-6
2.4.3 Cryogenics .................................................. 2-6
2.4.4 Tube Controller Board Battery .................................. 2-6
2.4.5 High Voltage Tank Oil ......................................... 2-6

3 Introduction to the MICROSTAR ..................................... 3-1

3.1 MICROSTAR Rotating Anode Principles of Operation ........... 3-1

3.2 MICROSTAR Components ......................................... 3-1
  3.2.1 X-ray Tube Cubicle ........................................ 3-2
  3.2.2 High-Voltage Trolley ...................................... 3-3
  3.2.3 Auxiliary Trolley .......................................... 3-3
  3.2.4 Bench or Enclosure ........................................ 3-4
  3.2.5 Operator Panel ............................................ 3-5
  3.2.6 Toolbox .................................................. 3-6

4 The MICROSTAR Operator Panel ................................... 4-1

4.1 Operator Panel Overview: Controls and Functions ............ 4-1
  4.1.1 Display .................................................. 4-2
  4.1.2 Menu Navigation Area .................................... 4-2
  4.1.3 Soft Buttons ............................................ 4-2
  4.1.4 Key Switches and Indicator LEDs .......................... 4-3

4.2 Management ..................................................... 4-4
  4.2.1 Super Managers .......................................... 4-5

4.3 Operate Menu .................................................... 4-6
  4.3.1 Generator ................................................ 4-6
  4.3.2 Recrystallize ............................................ 4-6
  4.3.3 Conditioning ............................................. 4-6
  4.3.4 Anode Speed ............................................. 4-6

4.4 Setup Menu ...................................................... 4-7
  4.4.1 Shutters ................................................. 4-7
  4.4.2 Generator ................................................. 4-8
  4.4.3 Tube .................................................... 4-8
  4.4.4 Management .............................................. 4-8
  4.4.5 Preferences .............................................. 4-8

4.5 Diagnose Menu .................................................. 4-9
  4.5.1 Error Logs ................................................. 4-9
  4.5.2 Trips ..................................................... 4-9
  4.5.3 Tube Switches ............................................ 4-9
  4.5.4 Observe .................................................. 4-10

4.6 Service Menu .................................................... 4-11
  4.6.1 Read ..................................................... 4-11
  4.6.2 Modify .................................................. 4-11
4.6.3 IO ................................................................. 4-11
4.6.4 Show Revision ........................................... 4-12
4.6.5 Ventilate ................................................... 4-12
4.6.6 What To Toggle ........................................... 4-12

4.7 View Menu .................................................... 4-13
4.7.1 Primary Status ........................................... 4-13
4.7.2 Setup Parameters ....................................... 4-13
4.7.3 Operation Parameters .................................. 4-13

4.8 Status Window ............................................... 4-15

4.9 Diagnostic Tool ............................................. 4-16

4.10 Water Level Indicator ..................................... 4-17

4.11 MICROSTAR / Warning Window ....................... 4-18
4.11.1 Faults and Errors ..................................... 4-19
4.11.2 In Case of a Fault ..................................... 4-19
4.11.3 In Case of an Error ................................... 4-19

4.12 X-ray Status Window ....................................... 4-20

4.13 Shutter Display Windows ................................. 4-21

5 Starting and Stopping the MICROSTAR .................. 5-1
5.1 Starting the MICROSTAR ................................... 5-1
5.1.1 Restarting After a Power Loss ....................... 5-2

5.2 Idling and Stopping the MICROSTAR .................... 5-2

5.3 Operating the MICROSTAR as part of a Bruker AXS System .................. 5-3

6 MICROSTAR Maintenance .................................... 6-1
6.1 Scope and Disclaimer ....................................... 6-1

6.2 Preventive Maintenance .................................... 6-1
6.2.1 Bruker AXS Preventative Maintenance Visits ........ 6-1
6.2.2 Customer-performed Preventative Maintenance .... 6-2

6.3 Filament Replacement ....................................... 6-2
6.3.1 General Information ................................... 6-2
6.3.2 Preparing to Change the Filament ................. 6-2
6.3.3 Cathode Mounting ..................................... 6-5
6.3.4 Recrystallization ..................................... 6-6
6.3.5 Preferent Bias ......................................... 6-6

6.4 Anode Water Seal Replacement ......................... 6-7
6.4.1 Disassembly ............................................ 6-7
6.4.2 Assembly ............................................... 6-7

6.5 Shutter Replacement ....................................... 6-8
6.6 Anode Drive Belt Replacement ................................................. 6-8
6.7 Anode Replacement ................................................................. 6-9
   6.7.1 General ................................................................. 6-9
   6.7.2 Rotor Plate Remounting ........................................... 6-9
   6.7.3 Anode Disassembly ................................................... 6-9
   6.7.4 Anode Cleaning ....................................................... 6-10
   6.7.5 Anode Remounting ................................................... 6-10
   6.7.6 Rotor Plate Mounting ............................................... 6-10
6.8 Ferrofluidic Seal Replacement .................................................. 6-11
6.9 Safety Tests ................................................................. 6-13
   6.9.1 Shutter Safety ......................................................... 6-13
   6.9.2 X-ray High Voltage Safety ........................................ 6-13

7 MICROSTAR Troubleshooting ...................................................... 7-1
7.1 Startup Errors ................................................................. 7-1
   7.1.1 Generator Does Not Go to The Power Up Status (But No Error is Shown) 7-1
   7.1.2 Generator Does Not Go to The Standby Status (But No Error is Shown) 7-1
7.2 Low Vacuum ................................................................. 7-2
7.3 Shutter Does Not Open ....................................................... 7-3
7.4 Error Codes on the Operator Panel ....................................... 7-4
7.5 Internal Error: Input Buffer Overrun .................................... 7-7
7.6 Communication Problem with Computer or Goniometer ............ 7-7
7.7 No mA ................................................................. 7-7
7.8 Service Program .............................................................. 7-7

8 Declaration of Conformity ....................................................... 8-1

9 Certificate of Radiation Safety .................................................. 9-1

10 Certificate of PCB-Free HV Tank Oil .............................................. 10-1

11 Spare Parts List ............................................................... 11-1
   11.1 Cathode and Focus ..................................................... 11-1
   11.2 Anode, Rotor Plate, and Drive ....................................... 11-2
   11.3 Vacuum ............................................................... 11-3
   11.4 HV circuit ............................................................ 11-3
11.5 Shutter ................................................................. 11-3
11.6 Cooling ............................................................... 11-4
11.7 Power ................................................................. 11-4
11.8 Units ................................................................. 11-5
11.9 Boards ............................................................... 11-5
11.10 Electronic Parts ................................................. 11-6
11.11 Lamps ............................................................... 11-6
11.12 O-rings .............................................................. 11-7
11.13 Tools ................................................................. 11-8
11.14 Maintenance Sets ............................................... 11-8
11.15 Other ............................................................... 11-9

Index ................................................................. Index-1
This page intentionally left blank.
1 About This User Manual

1.1 The MICROSTAR Rotating Anode Generator

The MICROSTAR is a microfocus rotating anode generator designed to generate a stable X-ray beam with high brilliance for accurate X-ray diffraction measurements.

This User Manual discusses the different components of the system and their interaction.

It describes how to use the generator, how to turn it on, how to check and change its settings, and how and when to turn it off.

It describes how to verify that the generator is running well and what to do when problems occur. Preventive maintenance is also covered.

It also explains how the system deals with different aspects of X-ray safety and how you can use the equipment in a safe manner.

We hope you will enjoy using the MICROSTAR.
1.2 Terms and Conventions Used in this User Manual

Before using this User Manual, it is important to understand the terms and typographical conventions used. Certain kinds of formatting in the User Manual’s text are used to identify special kinds of information.

1.2.1 Typographical Conventions

Table 1.1 shows typographical conventions used to help you quickly locate and identify information in this User Manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Software interface elements (such as icons, menu items, and buttons) to be selected as part of the current procedure.</td>
</tr>
<tr>
<td>italics</td>
<td>New terms and words requiring emphasis.</td>
</tr>
<tr>
<td>monospace</td>
<td>Information read from or entered into a command prompt.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Navigation through a hierarchical menu. For example, “Choose Start &gt; Programs &gt; Bruker AXS &gt; PILOT” describes navigating Windows’ menus from Start to Programs to Bruker AXS to PILOT.</td>
</tr>
<tr>
<td>[square brackets]</td>
<td>Keyboard input.</td>
</tr>
</tbody>
</table>

Table 1.1 – Typographical conventions

1.2.2 Equivalent Terms

Greek and Roman Text

This User Manual uses scientific terminology that may be rendered in Greek text. However, this User Manual follows a convention of using Roman text to the greatest extent possible.

<table>
<thead>
<tr>
<th>Greek</th>
<th>Roman</th>
</tr>
</thead>
<tbody>
<tr>
<td>2θ</td>
<td>2-theta</td>
</tr>
<tr>
<td>ω</td>
<td>omega</td>
</tr>
<tr>
<td>ϕ</td>
<td>phi</td>
</tr>
<tr>
<td>χ</td>
<td>chi</td>
</tr>
</tbody>
</table>

Table 1.2 – Greek and Roman text
1.2.3  Warnings, Cautions, and Notes

This User Manual contains notices that you must observe to ensure your own personal safety, as well as to protect the product and connected equipment. These notices are highlighted in the User Manual and are marked as follows according to the level of danger.

⚠️ WARNING

The word “WARNING” alerts you to an immediate or potential hazard that can result in death, severe personal injury, or substantial property damage.

⚠️ CAUTION

The word “CAUTION” alerts you to a potential practice or condition that could result in minor personal injury or damage to the product or property.

**NOTE:** The word “NOTE” in bold capital letters draws your attention to particularly important information on the product or handling of the product, or to a particular part of the product documentation.

1.3  Referenced Documentation

Table 1.3 contains a list of documentation referenced in this User Manual. It is necessary to have this additional documentation available as you work with this User Manual. In the documents' part numbers, a variable revision number is indicated by a lowercase letter “x”. Always use the most current revisions available.

<table>
<thead>
<tr>
<th>Documentation Part Number</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>M86-Exx71</td>
<td>MONTEL Graded Multilayer Optics User Manual</td>
</tr>
<tr>
<td>M86-Exx079</td>
<td>MICROSTAR Pre-installation Guide</td>
</tr>
</tbody>
</table>

Table 1.3 – Referenced documentation
1.4 X-ray Safety

**WARNING**

X-ray equipment produces potentially harmful radiation and can be dangerous to anyone in the equipment's vicinity unless safety precautions are completely understood and implemented. All persons designated to operate or perform maintenance on this instrument need to be fully trained on the nature of radiation, X-ray generating equipment, and radiation safety. All users of the X-ray equipment are required to accurately monitor their exposure to X-rays by proper use of X-ray dosimeters.

For safety issues related to operation and maintenance of your particular X-ray generator, diffractometer, and shield enclosure, please refer to the manufacturer's operation manuals or to your Radiation Safety Officer. The user is responsible for compliance with local safety regulations.

1.5 MICROSTAR Help and Technical Support

1.5.1 Technical Information on the Web

The latest technical information concerning the MICROSTAR is available at the following Web address:

http:\\www.nonius.nl\manuals

Additionally, the latest technical updates are available to registered users in the Downloads section of the Bruker AXS Web site:

http:\\www.bruker-axs.com
1.5.2 Technical Support

Users are invited to contact Bruker AXS whenever there are problems or questions related to the system. Before contacting Bruker AXS, please:

- Determine the version of the software (if there is a software problem);
- Record any error messages; and
- Determine the conditions and/or steps that recreate the problem.

If the instrument is in North America, contact our North American Service Center:

<table>
<thead>
<tr>
<th>Bruker AXS North American Service Center</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address:</strong></td>
</tr>
<tr>
<td>Bruker AXS Inc.</td>
</tr>
<tr>
<td>Customer Support</td>
</tr>
<tr>
<td>5465 East Cheryl Parkway</td>
</tr>
<tr>
<td>Madison, WI 53711-5373</td>
</tr>
<tr>
<td>USA</td>
</tr>
<tr>
<td><strong>Toll-free telephone:</strong></td>
</tr>
<tr>
<td>1 (800) 234-XRAY [9729]</td>
</tr>
<tr>
<td><strong>Direct line:</strong></td>
</tr>
<tr>
<td>1 (608) 276-3087</td>
</tr>
<tr>
<td><strong>Fax:</strong></td>
</tr>
<tr>
<td>1 (608) 276-3015</td>
</tr>
<tr>
<td><strong>E-mail:</strong></td>
</tr>
<tr>
<td><a href="mailto:Customer.Service@bruker-axs.com">Customer.Service@bruker-axs.com</a></td>
</tr>
<tr>
<td><strong>Web:</strong></td>
</tr>
<tr>
<td><a href="http://www.bruker-axs.com">http://www.bruker-axs.com</a></td>
</tr>
</tbody>
</table>

Table 1.4 – Bruker AXS North American Service Center contact information

If the instrument is outside North America, contact your local Bruker AXS Service Center.
This page intentionally left blank.
2 Safety Considerations

WARNING

The MICROSTAR generates X-rays, which can be hazardous if the following safety rules are not observed:

- This equipment must be operated under the authority of a Radiation Safety Officer, in accordance with local regulations.
- This equipment must be operated, serviced, and maintained by qualified personnel who are trained on the hazards of and precautions against X-ray exposure.
- This equipment contains safety circuits which should not be overridden other than with the supplied enclosure key. These overrides may only be used for service and maintenance, i.e., X-ray alignment.
- The “Open Beam” key should be kept in the custody of the Radiation Safety Officer, not with the instrument. This also applies to the X-ray or shutter safety keys, in case a certain X-ray port is not used or X-rays should not be used.
- Safety circuits must be tested by service personnel or by the Radiation Safety Officer at least every 12 months as described in this User Manual.
- Beam stop blocks must be mounted on unused output ports (see Figure 2.1). These blocks are delivered with the generator.
- If the MICROSTAR is delivered without an enclosure, the user must guarantee X-ray safety by placing the equipment in a safety room.
- The radiation enclosure is a shield for only the weak scattered radiation generated with normal X-ray diffraction equipment. When using other types of radiation or large samples, the shielding capacity must be recalculated and additional shielding might be required.
- Take into account the X-ray safety of other installed equipment.
2.1 Safety Features

2.1.1 Generator Safety Key

The safety keys are located on the front of the MICROSTAR near the X-ray tube and just under the tabletop. With the keys removed, the generator is disabled. The “ON” position is horizontal.

2.1.2 Radiation Safety Enclosure

The metal doors and panels are made from 1.25 mm steel plate. The transparent panels are made from PVC sheets. For Cu radiation (8 keV), the lead equivalent is 0.25 mm.

2.1.3 Generator Emergency Switch

“Emergency Off” pushbuttons are located on the front and rear panels of the generator. If pressed, they immediately isolate the electrical supply to all circuits. The pushbuttons are key-controlled and cannot be reset without the key. It is recommended that this key be kept in the custody of an authorized person, who can ascertain the nature of the emergency and be satisfied that no harm or damage will result by restoring the mains supply (i.e., resetting the pushbutton).

**NOTE:** For complete isolation of the equipment from the mains supply, the external isolator must be switched off. The external isolator should be fitted on the laboratory wall by the user’s building services.
2.1.4 External X-ray ON Lamp

The user can connect an additional fail-safe “X-rays ON” lamp. This lamp should have a filament 12V max 250 mA. To have the same functionality as the “X-rays ON” lamp on the X-ray tube, the lamp should be connected between pins 4 and 5 of user connector 2 just above the safety interlock panel (replace the resistor with the lamp). See Section 2.3.1 for more information on the safety interlock panel.

**NOTE:** If this lamp is located at the entrance of the generator room, it might not be visible from within the room. Consequently, it might not be recognized as the cause of a loss of X-ray high voltage if the lamp fails.

2.2 Safety Interlocks

The X-ray high voltage cannot be switched on, or is switched off, when:

- The shutter does not close.
- The tube cover is not in place.
- The “X-ray ON” light is defective.

The shutter is closed or does not open when:

- The shutter open indicators are defective.
- The radiation enclosure is not closed.
- The goniometer is not properly positioned in front of the X-ray port.
- An extra external safety switch is open.
- The mechanical interlock at the shutter is not open.

2.2.1 Radiation Safety Enclosure

All doors and sliding panels of the radiation safety enclosure are equipped with magnets. In the closed position, these magnets actuate the proximity switches and the safety circuit unlocks, making X-rays and shutter operation available.

2.2.2 “X-ray ON” Indicator

The “X-ray ON” indicator consists of illuminated strips on the left, rear and right side of the X-ray tube. These indicators are fail-safe. An additional indicator is the red LED on the operator panel.
2.2.3 “Shutter Enable” Key

Shutter 1 is the left shutter, as seen toward the tapered end of the X-ray tube. Shutter 3 is on the right side. A shutter cannot be opened when its “Shutter Enable” key is removed.

![Safety keys panel](image)

2.2.4 “Open Beam” Key

X-ray ports can only be opened when the radiation safety enclosure is closed or when the “Open Beam” key is in place. This key should be kept by the Radiation Safety Officer to ensure that work with an open radiation safety enclosure is only carried out under qualified supervision.

2.2.5 “Open Beam” Lamp

With the “Open Beam” key overriding the enclosure safety, the “Open Beam” lamp blinks to warn the user of the unusual working conditions. The lamp is fail-safe; when the lamp is defective, the shutter closes and cannot be opened.

2.2.6 Shutter Bayonet

A mechanical lock inside the shutter can only be released when the bayonet of the collimating device or X-ray optics is locked in place with a clockwise movement. Unused X-ray ports should remain covered with the safety blocks fitted at the time of delivery of the generator (Figure 2.1).

2.2.7 Tube Cover Safety Switches

The tube covers are essential to safe operation of the system. They provide radiation safety as well as protection against injury from the anode drive belt.
2.3 Enclosure Status and its Effect on X-rays and Shutter Operation

2.3.1 Safety Interlock Panel

The safety interlock panel, located in the High-Voltage trolley, is used to “program” safety actions with hardware wire connections.

**WARNING**

Any wiring changes may only be done by a qualified Bruker AXS Service Representative and should be certified by the local Radiation Safety Officer. Wiring by unauthorized personnel may result in failure of radiation safety interlocks.

The shutter and/or HV generator can be set to respond to “Open” or “Closed” status from the radiation safety enclosure. The standard wiring of the safety interlock panel is such that all shutters close when the enclosure is open. This means that a data collection session is interrupted when doors are opened. Data collection restart procedures depend on the program used.

An action **Enclosure Open = X-rays OFF** can be configured.

Independence between the left and right halves of the enclosure, each controlling a separate shutter, can also be configured.

“Open beam” overrides the enclosure door switches.
2.4 Potential Hazards

2.4.1 Beryllium

The X-ray tube contains windows made of beryllium. In normal use these areas cannot be reached, but care must be taken not to touch the window during maintenance. If the beryllium is touched by accident, wash thoroughly with soap and water.

Fumes and dust from beryllium metal can be hazardous if inhaled. During use, corrosion of the beryllium window may occur, but it should not be cut, machined or otherwise removed. Disposal must comply with national and local regulations governing beryllium.

2.4.2 Electrical Safety

Only qualified technical personnel may access the area under the MICROSTAR table. When a qualified technician wants to access these parts, first disconnect all automatic fuses and disconnect the mains supply before accessing any interior part of the generator.

2.4.3 Cryogenics

When using a liquid nitrogen cryostat in combination with the MICROSTAR, make sure that refilling of dewars can be done safely. Consider the use of automatic refill options if a dewar is located on top of the generator table or extra bench. Transport, handling and filling of dewar containers should be done by trained personnel aware of the hazards involved. It is strongly advised to read the safety instructions that are usually delivered with the dewar containers.

2.4.4 Tube Controller Board Battery

The Tube Controller Board contains a battery that should be regarded as chemical waste according to local regulations.

2.4.5 High Voltage Tank Oil

The HV tank contains PCB-free oil; see the Certificate in Chapter 10.
3 Introduction to the MICROSTAR

3.1 MICROSTAR Rotating Anode Principles of Operation

The MICROSTAR rotating anode X-ray generator consists of a high-voltage supply and an X-ray tube with a rotating anode. The hot filament in the cathode cup emits electrons that are accelerated by the high-voltage supply. The bias voltage, together with the shape of the focus cup, focuses the electron beam into a small focal spot on the anode. The impact of the electrons on the anode generates X-rays of an energy/wavelength of ~8 keV / 1.541838 Å (Cu anode).

Only a very small portion of the electrons' energy is converted into X-rays; the remainder of the energy is converted into heat. The rotation of the anode spreads the heat over a large area. This makes it possible to use higher loads compared with tubes using stationary anodes. The anode rotates under vacuum and is internally cooled with water. A ferrofluidic seal around the anode shaft maintains the vacuum while rotating. The high vacuum is maintained by continuous operation of an oil-free roughing pump and a turbomolecular pump (TMP).

3.2 MICROSTAR Components

The generator consists of the following:

- X-ray tube cubicle
- High-Voltage Trolley
- Auxiliary Trolley
- Bench or Enclosure
- Operator Panel
- Toolbox

Each component is described in detail in the following Sections.
3.2.1 X-ray Tube Cubicle

The X-ray tube cubicle, which extends above and below the tabletop, consists of:

- X-ray tube with anode and drive, filament and vacuum system
- Fail-safe “X-ray ON” and “shutter OPEN” lights
- Two shutters:
  - Shutter 1 (left-hand facing the tapered end of the X-ray tube) is the default shutter.
  - Shutter 3 is on the other side (the side of the anode’s “water manifold”, i.e., the side where the cooling water enters the anode).
- MONTEL or HELIOS focusing optics (optional)
- Vacuum gauge on top of the X-ray tube (gray cap)
- Safety keys to disable the shutters or override the radiation enclosure safety at the front panel
- Emergency “Power OFF” buttons (front and rear)
- Tube connector panel and TMP controller
- Roughing (pre-vacuum) pump located on the floor to avoid vibration

Figure 3.1 — MICROSTAR X-ray tube cubicle
3.2.2 High-Voltage Trolley

The high-voltage trolley, located under the tabletop, contains:

- ELCA module, a box with the electronics, and X-ray safety connection panel.
- High-voltage tank with a high-voltage transformer submerged in oil.
- Power inverter mounted on the side of the high-voltage tank.
- Oil pump that pumps the oil through the high-voltage tank and cathode for cooling these parts. The heat from the oil is transferred to the water cooling circuit by a heat exchanger on top of the tank.

![High-voltage trolley](image)

Figure 3.2 – High-voltage trolley

3.2.3 Auxiliary Trolley

The heat from the X-ray tube, the inverter, and the high-voltage tank is removed by demineralized water in a closed circuit containing a water circulation pump, a small water vessel, and a heat exchanger. The heat exchanger transfers the heat of this secondary cooling circuit to the laboratory cooling water supply (the primary circuit). The primary water flow is regulated by an adjustable thermostatic valve mounted on the heat exchanger. It stabilizes the temperature in the secondary circuit, avoids condensation, and limits the consumption of primary cooling water when less power is used. The isolation of the two water circuits makes the generator independent of local water quality and pressure.

![Auxiliary trolley](image)

Figure 3.3 – Auxiliary trolley
3.2.4 Bench or Enclosure

- In the smallest bench model, the half-width X-ray tube cubicle is extended by two table cubicles to A) house the high-voltage trolley and the auxiliary trolley and B) to support the experimental hardware. Extra cubicles may be added to accommodate larger hardware configurations. The bench model generators offer maximum ease of operation for liquid nitrogen cryostats. To ensure X-ray safety, such generators must be located in a designated safety room.

- The generator with integral radiation enclosure can be located in a large room with several experiments. The integral radiation enclosure is a shield to prevent access to the radiation area, and to protect the operator against background scattering associated with regular X-ray diffraction experiments. It is available with 2½-cubicle and 3½-cubicle generators.

Figure 3.4 – MICROSTAR bench model with PROTEUM R diffractometer and KRYO-FLEX system

Figure 3.5 – MICROSTAR with integral radiation enclosure
3.2.5 Operator Panel

- The operator panel is connected to the generator by a 4.5 meter cable. The panel must remain connected to the generator at all times. When disconnected, the generator shuts down immediately.

- For bench model generators, the operator is free to place the panel anywhere on the tabletop. The default left and right shutter designation can be changed in the generator software to reflect the actual side of access after installation in the laboratory.

- For enclosure model generators, the operator panel is located in a special slot in the metal front door of the radiation enclosure. During alignment, this door can be folded so that the operator has a good view of the experimental hardware as well as of the operator panel itself.

Figure 3.6 – MICROSTAR operator panel
3.2.6 Toolbox

The toolbox contains special tools for:

- Replacing the filament;
- Replacing the ferrofluidic seal;
- Replacing the water seals;
- Removing the recoil shield from the X-ray tube.

The toolbox also contains replacement parts.

Figure 3.7 – Toolbox
4  The MICROSTAR Operator Panel

4.1  Operator Panel Overview: Controls and Functions

The standard operation mode for the MICROSTAR is through the Operator Panel, described in this Chapter.

Figure 4.1 shows the Operator Panel’s controls and functions:

1. Menu Bar
2. Status window
3. Diagnostic tool
4. Water level indicator
5. Warning window
6. Menu navigation area
7. X-ray area
8. Status LEDs
9. Soft buttons
10. X-ray status window

Figure 4.1 – Operator panel overview
4.1.1 Display

The large backlit LCD display on the Operator Panel shows all information for the MICROSTAR and lets you navigate through its various controls. When the Operator Panel has not been used for some time, the display turns dark to conserve power. Using the trackball or pressing a button will restore illumination.

4.1.2 Menu Navigation Area

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trackball</td>
<td>Used like a computer mouse for selecting parts of the interface for viewing or editing.</td>
</tr>
<tr>
<td>[ENTER] button</td>
<td>Confirms a setting or enters the next deeper level of the menu structure.</td>
</tr>
<tr>
<td>[CLEAR] button</td>
<td>Cancels a setting or enters a higher level of the menu structure.</td>
</tr>
</tbody>
</table>

Table 4.1 – Menu navigation area functions

4.1.3 Soft Buttons

These four yellow buttons along the bottom of the display have functions that change depending on the current state of the generator. For each soft button, its current function is shown directly above it.

**NOTE:** The shutter display windows show the functions of the yellow shutter buttons (their next actions), not their present status. The yellow LED next to the shutter button shows the present shutter status. So the text “OPEN” in the shutter display window means that the shutter will open when the button is pressed.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stdby</td>
<td>With this button, the system can be switched to Standby status (internal water, oil, vacuum and anode motor started) or back to Power Up status.</td>
</tr>
<tr>
<td>HotKey</td>
<td>With this button the most commonly-used display window is opened: Operate &gt; Generator.</td>
</tr>
<tr>
<td>Shutter 1 and 3 soft buttons</td>
<td>Opens and closes the shutters. The shutters can also be opened and closed by the goniometer. To prevent unauthorized opening of the shutters, the shutters can be disabled by turning off the safety key switches under the X-ray tube.</td>
</tr>
<tr>
<td>Red X-RAY soft button</td>
<td>Switches the High Voltage ON and OFF. When pressed in the Power Up status, the system is promoted to the Standby status and proceeds automatically to the X-ray ON status.</td>
</tr>
</tbody>
</table>

Table 4.2 – Soft button functions (from left to right)
### Standby Soft Button Labels

<table>
<thead>
<tr>
<th>Standby Soft Button</th>
<th>Function of the button (next action, not the present status) or warning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the status or the intermediate status (from which to which status)</td>
<td></td>
</tr>
<tr>
<td>POWER UP</td>
<td>Only power on.</td>
</tr>
<tr>
<td>STANDBY</td>
<td>All equipment running and ready to generate X-rays.</td>
</tr>
<tr>
<td>GENERATE</td>
<td>Generates X-rays, HV is on.</td>
</tr>
<tr>
<td>#1 - #2</td>
<td>Going from status #1 to #2</td>
</tr>
<tr>
<td>#</td>
<td>Stable at status #</td>
</tr>
<tr>
<td>To #1 - #2</td>
<td>First fallback to #1, then buildup to #2</td>
</tr>
<tr>
<td>sec/10 sec</td>
<td>Timeline of transition. sec = seconds, sec/10 = in 10 sec units</td>
</tr>
<tr>
<td>sec</td>
<td>command delay time</td>
</tr>
<tr>
<td>sec/10</td>
<td>condition timeout</td>
</tr>
</tbody>
</table>

Table 4.3 – Standby soft button labels

### Shutter Soft Button Messages and Next Actions

<table>
<thead>
<tr>
<th>Message</th>
<th>Next Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Press to open the shutter. “PANEL” is the manager and control is by the MICROSTAR software.</td>
</tr>
<tr>
<td>Close</td>
<td>Press to close the shutter. “PANEL” is the manager and the control is by the MICROSTAR software.</td>
</tr>
<tr>
<td>Clear</td>
<td>Press to clear a pending “shutter open” command. This situation occurs when a shutter does not open because there is no shutter bayonet fitted. In that case, a shutter must be cleared before it can be opened again. “PANEL” is the manager.</td>
</tr>
<tr>
<td>Reset</td>
<td>Press to reset the shutter. In Setup &gt; Shutters, the control switches from “hardware” to “software” and at the same time the shutter closes. “PANEL” is the manager.</td>
</tr>
</tbody>
</table>

Table 4.4 – Shutter soft button messages and next actions

### Key Switches and Indicator LEDs

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER LED and Key</td>
<td>When turned from OFF to ON, the display is started and PWRUP is displayed. The LED shows whether power is enabled; the key is required to enable the power. The POWER key switch makes it possible to prevent unauthorized access to the system. When the generator is in Standby or Generate status, this switch is bypassed by the electronics and shutdown by this switch is in a controlled way. <strong>Immediate shutdown is only possible with the emergency buttons at the front and rear of the tabletop.</strong></td>
</tr>
<tr>
<td>X-RAY LED and Key</td>
<td>The LED shows whether X-ray generation is enabled; the key switch is used to enable the generation of X-rays (not to switch on the X-rays). The absence of this key prevents unauthorized use of X-rays.</td>
</tr>
<tr>
<td>Shutter 1 LED</td>
<td>Lights when Shutter 1 is open. The key to enable manual control of Shutter 1 is not on the operator panel; it is located on the generator bench beneath the tabletop.</td>
</tr>
<tr>
<td>Shutter 3 LED</td>
<td>Lights when Shutter 1 is open. The key to enable manual control of Shutter 3 is not on the operator panel; it is located on the generator bench beneath the tabletop.</td>
</tr>
</tbody>
</table>

Table 4.5 – Key Switches and indicator LEDs
4.2 Management

Before using the MICROSTAR, it is important to understand the concept of management.

The MICROSTAR has been designed as a node in a fully integrated data collection system. Integration is available at all aspects of software, hardware, and radiation safety. Two data collection sessions can run simultaneously and independently.

Different parts of the system may be controlled in different ways. For example, X-ray power settings may be controlled from the operator panel while Bruker AXS software controls the shutter.

To determine which parts of the system are controlled by the panel or by external software, the system is divided into objects (such as X-ray generation, Service mode, and shutter control) which are managed either by the panel or have no manager, or are controlled externally over an RS232 connection (i.e., by Bruker AXS software). Also, hardware (safety) contacts may prevent the execution of a command.

A manager may obtain or release control over any object, and any object may be controlled by any manager. For example, management settings may be obtained from the operator panel, or released from the panel so that external control is allowed.

To obtain or release management for an object:

1. Go to Setup > Management. The Management window will open.

2. Select the object for which you wish to obtain management and press [Enter]. The options release and obtain appear next to the selected item.

3. Select obtain. The management for the selected object changes to “PANEL”.

Bruker AXS systems are designed to operate as fully integrated data collection systems. With these systems, the operator panel may not be the manager of some objects. Two horizontal lines indicate this. Vertically hatched items can only be changed in the Setup menu provided that “PANEL” is the manager.
### Table 4.6 – Default management settings

<table>
<thead>
<tr>
<th>Object</th>
<th>Default Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-ray</td>
<td>Panel</td>
</tr>
<tr>
<td>Shutter 1</td>
<td>Panel</td>
</tr>
<tr>
<td>Shutter 2</td>
<td>Panel</td>
</tr>
<tr>
<td>Service</td>
<td>No manager</td>
</tr>
</tbody>
</table>

**4.2.1 Super Managers**

A hardware jumper determines the hierarchy among the managers.

Examine the top two bits of the middle group of indicators in the Diagnostic Tool to identify the Super Manager.

When the two top bits of Super Manager are dark, the Super Manager is **RS232**. When the two top bits of Super Manager are illuminated, the Super Manager is **Panel**.

More information on Managers and Super Managers is available from your Bruker AXS Service Representative.
4.3 Operate Menu

![Operate menu](image)

4.3.1 Generator

The “HotKey” soft button gives direct access to this menu.

The figures in the “limit” column are set in the Setup > tube > limits > user set menu.

The kV and mA values in the “goal” column are the settings for the current experiment.

The hatched bias value is the preferred setting for the current filament. It is set in the Setup > Preferences > preferent bias menu.

4.3.2 Recrystallize

Baking the filament (Recrystallization) redistributes the stresses in the filament induced during filament winding. Every new filament must be baked. Baking starts when the vacuum is better than 10⁻⁶ mbar without high voltage. During this process, the filament current is stepped up and stepped down in a controlled manner. The duration of the process depends on the quality of the vacuum. The average time for baking is 30 minutes. During the baking process, the message “running” is displayed. The message “done” at the end of the process remains visible until “running” is displayed again in a new baking session.

4.3.3 Conditioning

Conditioning cleans the inside of the X-ray tube by stepping up the tube power. This is required when the tube’s vacuum chamber has been exposed to air for a longer time. Conditioning starts when the vacuum is lower than 10⁻⁶ mbar. Voltage and current are increased stepwise until user limits have been reached. The program steps down one step when the vacuum gets worse or when too many trips occur, and continues from that level. When conditioning is finished, the kV is at the user limit and the mA is reduced to 90% of the user limit. For best performance, set “user limits” 5kV higher than regular use. During the conditioning process, the message “running” is displayed. The message “done” at the end of the process remains visible until “running” is displayed again in a new conditioning session.

4.3.4 Anode Speed

Choose an anode speed higher then the default calculated anode speed.
4.4 Setup Menu

4.4.1 Shutters

Setup > Shutters > Shutter Control

Select “Hardware” when the shutter is controlled by a goniometer (or other device) connected to the GCU connector. With this setting, it is not possible to open or close the shutter from the operator panel.

Bruker AXS goniometers connected at the GCU connector have extensive data collection software with a MICROSTAR software plug-in.

Select “Software” when the shutter is controlled by the MICROSTAR software.
4.4.2 Generator
Modules Used is fixed at Module 1.

4.4.3 Tube
The focus, filament, and target are fixed.

Setup > Tube > Tube Configurations > Limits
The voltage and current figures in the Tube column represent the maximum rating of the power supply. The maximum power limit of the anode with a 0.1 × 1 mm hot spot is 2.7 kW. The image of this hot spot under a takeoff angle of 6 degrees is a 100 × 100 micron spot. The user can set maximum kV and mA values for all new experiments. A common setting of the limits is 45 kV and 60 mA. Be sure that you have management (Setup > Management) and that the generator is in status “Power up”.

4.4.4 Management
Assigns managers to objects. For more information on managers and objects, see Section 4.2.

X-ray and Shutters default: “PANEL”. When an external program (i.e., Bruker AXS software and Super Manager set to RS232) needs X-ray management, it takes over automatically and “NO MANAGER” or “RS232” will show.

Service default: “NO MANAGER”. Do not change this management setting unless asked to do so by a Bruker AXS Service Representative.

4.4.5 Preferences
Setup > Preferences > Date/time, Units, Contrast
Selects the format for date/time (European / American) and units (ISO, USA, British).

NOTE: Do not reduce the contrast. The position of the cursor will be lost.

Setup > Preferences > Shutter buttons
When the operator accesses the generator from the side with the “X-ray ON” lights, it is more intuitive to exchange the assignment of the shutter buttons.

The default left shutter button is assigned to shutter 1. This is the shutter on the left side facing the tapered end of the X-ray tube.

The default right shutter button is assigned to shutter 3.

Set up > Preferences > Preferent bias
The optimum bias setting for the MICROSTAR electron gun depends on the position of the filament inside the focusing cup and is independent of the kV setting. For a certain filament setup, the optimal bias setting can be determined from the image of the double-reflected beam at the exit of the optic using a Xyclops.

Figure 4.7 – Xyclops with X-ray safe adapter to optic

Set bias = 0 and align the optic for the highest intensity. Once the alignment is optimal, increase the bias stepwise and determine the setting with the highest intensity. Enter this value as the preferent bias.
4.5 Diagnose Menu

4.5.1 Error Logs

At a fault, the generator program stops and continues automatically after 30 seconds. An error is an event that temporarily interrupts the generator program and is handled after a confirmation. Three faults since power up result in an error. The fault counter is reset after generating an error and not as a function of time. Thus, a single fault may be #3 and consequently result in an error. When the generator does not respond as expected, check the error log in the Diagnose menu for pending errors and follow the instructions on the screen.

0 = the most recent fault. The format of the message is: node number, fault id followed by text. Go back in time by entering a higher fault number. Faults have no time stamp.

0 = the most recent error. The format of the message is: node number, error id followed by text. Go back in time by entering a higher error number. Errors have a time stamp.

4.5.2 Trips

Displays the number of trips since last power up.

4.5.3 Tube Switches

When the code is 7, all covers are in place. If not 7, check the position of the tapered shield covering the cathode, the housing of the shutter open lights, or the top cover.
4.5.4 Observe

0
Displays the filament current in A. For a given kV, mA, and bias setting, the filament current tends to decrease with time. If you keep records about the filament current, you will be able to develop a general rule for predicting the end of filament life.

1
Displays the converter frequency in kHz. The frequency decreases with increasing X-ray power. The combined information available in Observe 1 and Observe 2 is a tool for the Bruker AXS Service Representative to diagnose problems in the power converter.

2
Display Pib in volts. This is a measure of the “ignition” voltage for the semiconductor switching devices in the generator’s power converter. The combined information available in Observe 1 and Observe 2 is a tool for the Bruker AXS Service Representative to diagnose problems in the power converter.
4.6 Service Menu

Figure 4.9 – Service menu

This menu accesses the special service commands. **Do not** enter this menu unless asked to do so by Bruker AXS Service. The default for the Service object is “NO MANAGER” so that accidental changes are not possible.

4.6.1 Read

Reads contents of memory. By default it will give the data of four successive addresses in hexadecimal format, starting with the input address (which will be supplied by Bruker AXS Service).

4.6.2 Modify

No user access. Writes to the memory.

⚠️ **CAUTION**

Be careful; incorrect writing can put the system in a dangerous state, resulting in damage.

4.6.3 IO

Reads and writes I/O registers.

⚠️ **CAUTION**

Be careful; incorrect writing can put the system in a dangerous state, resulting in damage.
4.6.4 **Show Revision**

Shows board revisions and software versions. Board revisions are configured with resistors at the board in question. Note that the Generator controller and the Tube controller have a submenu with board revisions.

4.6.5 **Ventilate**

This option brings the vacuum chamber to atmospheric pressure (to change the filament). Switch off X-rays and press the left yellow soft button so that the generator goes to Power Up status. The generator must cool down and the turbomolecular pump stops. Air is let in through the valve on the roughing (membrane) pump. A microfilter removes particles and moisture from the air so that it is no longer necessary to vent the vacuum chamber with nitrogen gas as was recommended with previous generators.

4.6.6 **What To Toggle**

The two or four small bright buttons under “Service” represent two or four user mains options that are available with MICROSTAR generators. Buttons 1 and 2 represent the switched internal user mains supplies (no longer available since mid-2004). Buttons 3 and 4 represent the user relays that can be used to switch external devices. The user relay terminals are located on the backplane just above the safety interlock panel. (0.5 A SB fuses) For more information, contact your Bruker AXS Service Representative.
4.7 View Menu

The pull-down menus under View will be displayed permanently at the rightmost available side of the screen by pressing the [Enter] key while the Hand tool is in the top section of that submenu. To remove a permanent display press [Cancel] with the Hand tool in the top section.

4.7.1 Primary Status

Shows kV, mA, bias, vacuum and actual anode speed.

4.7.2 Setup Parameters

This menu is the condensed display of the settings in the Setup menu. It displays the RS232 parameters, the status of the shutters, and the MICROSTAR tube parameters. It also displays information on interlocks stopping shutter operation (if any).

4.7.3 Operation Parameters

The status of the mechanical devices as well as the temperatures of the various flows are available. ON /OFF status is displayed for:

- Water pump;
- Oil pump;
- Vacuum pump;
- Anode motor.
Temperature is displayed for:

- The oil inside the HV tank;
- The incoming water (from Ext);
- The cold side internal (secondary) circuit;
- The warm side internal (secondary) circuit;
- The water from the anode.

The temperature of all water flows should be less than 40°C. A rough guide for proper cooling is: From Ext 20°C; 28°C Int 33°C; Anode out 34°C at 2.7 kW.

Lower water temperatures for “Int” and “Anode out” indicate that a lower consumption of cooling water is possible by adjusting the thermostatic valve for less flow. More valve throttle gives a wider range of regulation, resulting in better temperature stability in the internal water system of the MICROSTAR.
4.8 Status Window

The Status window displays the generator state. The blinking area in the left corner indicates that the generator is active.

During a transition phase, the actual state and the new state are displayed. The message TO status1 – status2 occurs in case of a recovery from a fault, Status1 being the starting point for the recovery procedure.

A thin time line displays the progress of a transition. There are two types of time lines:

--- displays a delay with a fixed duration (e.g., wait 2 minutes to rev down the TMP before venting the X-ray tube).

--- displays a process with a variable duration (e.g., start conditioning of the X-ray tube after the vacuum has reached 10E-6 mbar).

The time scale on the long bar is seconds. On the short bar, the time scale is 10 seconds.
4.9 Diagnostic Tool

Figure 4.12 – Diagnostic tool

Top left is bit 1.7 (byte 1 bit 7 - most significant bit)

Top right is bit 2.7

Bottom left is bit 5.0

Bottom right is bit 6.0 (byte 6 bit 0 – least significant bit)

For an explanation of the bits, select them in an empty screen.
4.10 Water Level Indicator

When this section is dark, the water vessel should be filled. Use demineralized water.
4.11 MICROSTAR / Warning Window

In this window, the name MICROSTAR is displayed. In case of a fault or error, the error message is displayed. At a fault, the generator program stops and continues automatically after 30 seconds.
4.11.1 Faults and Errors

An error is an event that temporarily interrupts the generator program and is handled after a confirmation. Three faults result in an error. The fault counter is reset after generating an error and not as a function of time. Thus, a single fault may be #3 and consequently result in an error. When the generator does not respond as expected, check the error log at the Diagnose menu for pending errors and follow the instructions on the screen.

An example of a fault is: you start X-rays but the X-ray enable key is in “off” position. Turn the key and press the [Clear] button. Depending on management the generator program continues immediately or after 30 seconds.

4.11.2 In Case of a Fault

In case of a fault, press the [Clear] button to continue the generator program.

When “PANEL” is not the manager of “X-ray”, the message is removed from the display but the generator program continues after 30 seconds.

When “PANEL” is the manager of “X-ray”, the message is removed from the display and the generator program continues immediately.

4.11.3 In Case of an Error

In case of an error, press the [Clear] button to handle the error and start the generator program:

When “PANEL” is not the manager of “X-ray”, the message is removed from the display but the program will not start until the manager of “X-ray” confirms the error. A user at the operator panel can obtain the management of “X-ray” (Setup > Management) and consult the Diagnose > Error Log menu.

When “PANEL” is the manager of “X-ray”, the message is removed from the display, the error is handled, and the generator program starts.
4.12 X-ray Status Window

Figure 4.15 – X-ray status window

<table>
<thead>
<tr>
<th>Message</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>When X-rays are off, possible displays are:</td>
<td></td>
</tr>
<tr>
<td>Start Generate</td>
<td>Press the red button to start X-rays.</td>
</tr>
<tr>
<td>noXray manager</td>
<td>First obtain “X-ray” management.</td>
</tr>
<tr>
<td>other manager</td>
<td>Another “X-ray” manager is active.</td>
</tr>
<tr>
<td>When X-rays are on, possible displays are:</td>
<td></td>
</tr>
<tr>
<td>Stop Generating</td>
<td>Press the red button to shut down X-rays.</td>
</tr>
<tr>
<td>Kill Generating</td>
<td>Press the red button to grab X-ray management and shut down X-rays.</td>
</tr>
<tr>
<td>Generating busy:</td>
<td>“PANEL” is not the manager of X-ray and the Super Manager is RS232.</td>
</tr>
</tbody>
</table>

Table 4.7 – X-ray status window messages
4.13 Shutter Display Windows

![Shutter display window](image)

**NOTE:** The information in this window has two different formats:
[* text*] indicating the **status**, where * is shutter 1 or 3, or [text *] indicating the **next action**, where * is shutter 1 or 3.
The messages displayed depend on the status of the generator.
The statuses are:

<table>
<thead>
<tr>
<th>Message</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Gone</td>
<td>The shutter cannot be opened as the “shutter present switch” inside the shutter is not closed or the wiring is disconnected. Ask your Bruker AXS Service Representative for advice. This message is only available at X-ray ON.</td>
</tr>
<tr>
<td>* LockX</td>
<td>The shutter cannot be opened as the shutter interlock on the safety interlock panel is not closed. See the description of the safety interlock panel (Section 2.3.1). When Bruker AXS goniometers are installed, safety switches may be fitted to verify the goniometer position in front of the X-ray tube and/or primary collimator and beam stop. Check these switches.</td>
</tr>
<tr>
<td>* LockA</td>
<td>The shutter cannot be opened as the “all shutter” interlock on the safety interlock panel is not closed. Check enclosure doors.</td>
</tr>
<tr>
<td>* Key</td>
<td>The shutter cannot be opened. Check the shutter key at the safety panel near the X-ray tube. This message is only available at X-ray ON.</td>
</tr>
<tr>
<td>* Remote</td>
<td>The shutter cannot be opened as the safety interlock on an external device connected to a GCU connector is not closed. The safety feature at the GCU connector is available when a hardware strap is made (during initial installation of the external device). This message is only available at X-ray ON.</td>
</tr>
<tr>
<td>* Error</td>
<td>Unspecified shutter error, e.g., shutter does not close or closes too slowly.</td>
</tr>
<tr>
<td>* Hardware</td>
<td>The shutter is closed. An external device connected to the GCU connector controls the shutter. “PANEL” is manager of the shutter, but you should make sure that the process on the external device has finished before operating the shutter from the operator panel.</td>
</tr>
<tr>
<td>* Clos’d:</td>
<td>The shutter is closed and is not managed by “PANEL”.</td>
</tr>
<tr>
<td>* Stuck</td>
<td>The shutter is not closed and not managed by “PANEL”, and there is no command to open the shutter. Hardware problem.</td>
</tr>
<tr>
<td>* Set</td>
<td>The shutter is not open and not managed by “PANEL”, and there is a command to open the shutter. Typically a mechanical cause, e.g., no shutter bayonet, defective rotary shutter solenoid.</td>
</tr>
<tr>
<td>* Open</td>
<td>The shutter is open but is not managed by “PANEL”.</td>
</tr>
</tbody>
</table>

Figure 4.17 – Shutter status messages

The “next actions” are:

<table>
<thead>
<tr>
<th>Message</th>
<th>Next Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open *</td>
<td>Press to open the shutter. “PANEL” is the manager and control is by the MICROSTAR software.</td>
</tr>
<tr>
<td>Close *</td>
<td>Press to close the shutter. “PANEL” is the manager and control is by the MICROSTAR software.</td>
</tr>
<tr>
<td>Clear *</td>
<td>Press to clear a pending “shutter open” command. This situation occurs when a shutter does not open because there is no shutter bayonet fitted. In that case, the shutter must be cleared before it can be opened again. “PANEL” is the manager.</td>
</tr>
<tr>
<td>Reset *</td>
<td>Press to reset the shutter. In Setup &gt; Shutters, the control switches from “hardware” to “software” and at the same time the shutter closes. “PANEL” is the manager.</td>
</tr>
</tbody>
</table>

Table 4.8 – Shutter next actions
5 Starting and Stopping the MICROSTAR

5.1 Starting the MICROSTAR

NOTE: To familiarize yourself with the operator panel controls, please read Chapter 4.

NOTE: The information below refers to the operation mode as “standalone generator” where “Panel” is the manager over the objects X-ray, shutter1 and shutter 3. (see Setup > Management).

NOTE: At the end of this Chapter, the difference in instructions for control of the MICROSTAR by a Bruker AXS data collection program will be given.

1. First, check whether the laboratory cooling water supply is available. The MICROSTAR uses temperature sensors rather than flow sensors, so a lack of flow will not be noticed. As long as the temperature in the internal water circuit remains below 40°C, the generator will operate without external cooling water. However, once at power, the generator will switch off quickly without external water cooling.

2. Turn the Power key to the “ON” position. The display window will show Stdby.

3. Turn the X-ray key to the “ON” position to enable X-rays to be generated.

4. Press the “Stand by” soft button. The pumps and the anode motor will start and the Status Window will change from “Power up” to “Standby”. The X-ray control window shows “Start generate”.

5. Press the “HotKey” button and select the kV and mA values for the current experiment. We advise 45 kV, 60 mA.

6. If the tube has been exposed to atmospheric pressure and/or the filament is new, select Operate > Recrystallize and/or Operate > Conditioning. Otherwise, skip this step.

7. Press the red X-ray button. The status window shows “Stand by – Generate” and, once the set kV and mA values have been reached, the status window shows “Generating”. The X-ray control window shows the next action of the red button: “Stop Generating”.

8. Wait 30 minutes to one hour to stabilize the beam before starting a data collection.

NOTE: While the MICROSTAR is generating, press the yellow shutter soft button to open the shutter.
5.1.1 Restarting After a Power Loss

1. Proceed as above, but verify the optic setting as the vacuum in the optic was lost.

5.2 Idling and Stopping the MICROSTAR

At the end of a data collection, it is best to turn down the power but keep X-rays ON. In this way there is a minimum variation of the stress on the filament.

NOTE: The longest filament life is obtained with relatively high kV and low mA, avoiding extra heating of the filament due to the fallback of electrons. We recommend 45 kV, 5 mA as standby settings.

With X-rays ON, there are 3 ways to stop the generator in a controlled way:

- When pressing the red button, X-rays are stopped and the generator falls back to the “standby” state so that it is immediately available to generate X-rays again.
- When pressing the left yellow button, the generator falls back from X-ray ON to Power up. All pumps and motors are turned off. The vacuum will gradually deteriorate but the vacuum chamber is not vented.
- When turning off the Power key switch the generator falls back from X-ray ON to Power OFF.
5.3 Operating the MICROSTAR as part of a Bruker AXS System

When the MICROSTAR is part of a Bruker AXS data collection system, the manager of the objects “X-ray” and “Shutter” is RS232 and shutter control must be set to hardware (see Setup > Management and Setup > Shutters > Shutter Control). The generator settings kV, mA, and X-ray ON/OFF are done on the data collection terminal. The shutter is controlled by the data collection program.

When the shutter closes because the radiation enclosure is opened, data collection stops. When the doors are closed again, data collection is resumed automatically and repeats the interrupted scan. The data collection program monitors the “X-ray stable” signal from the MICROSTAR during data collection. After a trip (internal discharge in the vacuum chamber), data collection will stop for 30 seconds and then repeat the interrupted scan.

**NOTE:** Although the Panel is not the manager of “X-ray” and “Shutter”, it is still possible to switch off X-rays or close the shutter from the operator panel for emergency reasons. Of course, this might interrupt a running data collection.

**NOTE:** When the MICROSTAR is put back into operation after a long period it is advised to run Conditioning (Operate > Conditioning) before starting a data collection.
This page intentionally left blank.
6 MICROSTAR Maintenance

6.1 Scope and Disclaimer

The mechanical maintenance described in this Chapter is intended for users who have attended a maintenance course. It comprises only a part of the required periodic maintenance.

The skill of an experienced Bruker AXS Service Representative is required for items related to high power, delicate mechanics, and vacuum. When problems arise with these items, please discuss the situation with Bruker AXS Service before attempting any repair or maintenance.

NOTE: Bruker AXS cannot give free technical support for work outside what is described in this User Manual, and is not responsible for work done by users.

6.2 Preventive Maintenance

For the longest operational lifespan of the MICROSTAR, yearly preventive maintenance is strongly advised.

WARNING

Some of the generator’s moving parts have a limited lifespan and can cause extensive damage to the MICROSTAR if not replaced in time.

6.2.1 Bruker AXS Preventative Maintenance Visits

A yearly preventative maintenance by Bruker AXS Service consists of:

- Replacement of the ferrofluidic seal, filament, TMP lubrication, carbon brush in the water manifold, and V-belt.
- Polishing and cleaning the focus cup, recoil shield, anode, water manifold, and vacuum gauge.
- Optional: refurbishment of the anode, or replacement by a new or refurbished anode.
- Check of safety devices.
- Several other checks.
6.2.2 Customer-performed Preventative Maintenance

Some items mentioned in this Chapter can be done by the user after a maintenance course, but there are limitations:

- The anode can only be polished, but sometimes grinding is needed. Incorrect grinding can cause pollution to be pressed into the anode material, causing a bad vacuum by heavy outgassing. Also, mineral deposits inside the anode should be removed, otherwise the cooling becomes less efficient. This results in overheating of the anode, which is shown by a bad vacuum caused by heavy outgassing. This refurbishment can only be done at the factory.
- The recoil shield can only be cleaned in situ, because of the risk of vacuum leaks as a result of incorrect remounting.
- See the Parts List at the end of this User Manual for the parts required on a yearly basis.

6.3 Filament Replacement

Filaments are supplied in a set together with mounting rod screws, clamp segments, Allen wrenches, and cathode O-rings.

6.3.1 General Information

When mounting a new filament:

- Clean parts should be handled with lint-free, powder-free gloves.
- Filaments should be handled with plastic tweezers only.
- All parts around the focus should be mounted by hand, never using a tool other than the locking key, and never using force. When removal cannot be done by hand, put some acetone in the screw-thread. If it is still not possible to remove or mount the focus cup assembly, return the parts to Bruker AXS.

Cleaning the cathode is occasionally necessary and should only be done by a Bruker AXS Service Representative. Ceramic parts should only be cleaned with a diamond file. Metal parts should be cleaned first using Scotchbrite 07447 or 07448, and then rinsed and brushed with acetone. It is important that no residues are left behind, since any residues will pollute the vacuum.

6.3.2 Preparing to Change the Filament

When a filament breaks, the operator panel will show a message and the generator will go into Standby status.

1. Go to status Power UP.
2. If the filament broke at high power, wait at least thirty minutes for it to cool down.
3. Unscrew (a couple of turns) the two screws at the bottom of the tapered tube cover and remove the screw at the top near the vacuum gauge. Remove cover.
4. Unscrew the small Allen screw that locks the HV cable nut. Remove the HV connector.
5. Discharge cable by touching the 3 cable pins against the blank metal parts of the X-ray tube.
6. Confirm that the filament is broken by measuring the resistance in the HV connector with (long) measuring probes between the COMMON and FILAMENT contacts (Figure 6.1). An intact filament has a low resistance.

7. Select **Service > Ventilate** at the operator panel to ventilate the X-ray tube.

8. Switch off the generator completely.

9. Remove the cathode. Take care not to change the distance S (Figure 6.1).

10. Measure the distance D (Figure 6.1).

![Filament Diagram]

11. Loosen the four Screws A, without removing them.

12. Unscrew the height adjustment nut while lifting off the entire focus cup assembly. A rocking motion may be necessary to remove the assembly.

13. Remove two uppermost screws B, which hold the filament in its mounting rods. Remove the filament.

14. From the filament set, place two new Screws B using an Allen wrench.
15. Place the new filament with the leads in the grooves. The spacing of the filament leads has a tolerance, so sometimes one wire must be pushed gently into the groove.

16. Place the filament height setting jig and, using plastic tweezers, gently adjust the position of the filament such that the filament sits between the marks and against the top of the jig. Gently fasten the two screws B. This is the most important step for a good alignment!

17. Place the entire assembly over the filament on the cathode, taking care that the cup does not touch the filament. Screw the assembly into place.

18. Check the position of the filament (Figure 6.2).

![Figure 6.2 – Correct position of filament](image)

19. If the focus cup needs to be re-aligned to the filament, loosen the locking ring (with the locking ring key), align the focus cup, and tighten the locking ring again.

20. Place the shorting key in the cathode.

21. Carefully place the depth gauge on the focus cup, avoiding any damage to the filament. Adjust the height of the filament with the height adjustment nut until the LED in the depth gauge is just on.

22. Tighten the four screws A so that the filament sits in the center of the cup. Do not use force on the screws as this can deform the mounting tube, causing problems in removing it from the ceramic disk.

---

**NOTE:** Turn the height adjustment nut slightly up, so that it is not tight but free. The four screws A hold the assembly in place.

23. Once the filament is at operating temperature, it can be (slightly) deformed. Usually this poses no problem. The deformation is due to a mismatch of the pitch of the filament leads and the slots in the cathode rods or by incorrect tightening of the screws B.

24. Re-check proper tightening of all screws.

![Figure 6.3 – Filament deformation and tightening of screws](image)
6.3.3 Cathode Mounting

![Diagram of cathode mounting]

**NOTE:** Skip steps 1-4 when the fixed distance cathode base is present.

1. Re-measure D, X, and Y (if not noted during the last filament change). Keep a log of the distances for future replacements: Y will never change, and X will only change after an anode replacement. Distance AC should be 8.5 mm for the 100-micron MICROSTAR focus.

2. If D is within ± 0.2 mm of the old value, remount the cathode without changing the setting of S.

3. If D is outside ± 0.2 mm, calculate the new distance \( S = (AC + D + Y) - X \).

4. Adjust the threaded collars and adjust this distance with the slide-rule (delivered with the generator) before the cathode is placed against it. The distance \( S \) should be as good as possible, but at least with an accuracy of 0.2 mm.

5. Mount the cathode carefully. The filament must be visually horizontal. When the oil outlet is on top, the filament is about horizontal.

**WARNING**

If the filament is accidentally mounted vertically (i.e., in the plane of the rotation) the anode will be overheated locally and the anode will be destroyed.

6. Remove the shorting key.

7. Refit the HV cable. Tighten the nut and the small locking screw.
8. Refit the tapered tube cover and select **Diagnose > Tube switches**. The value 7 indicates that all covers are placed correctly.

![Tools](image)

**Figure 6.5 – Tools**

### 6.3.4 Recrystallization

1. Start the generator and select **Operate > Recrystallize**. Allow some time for the process to finish.

### 6.3.5 Preferent Bias

1. Redo the Preferent Bias procedure described in Section 4.4.5.
6.4 Anode Water Seal Replacement

The water seal in the water manifold needs to be replaced at least every year.

6.4.1 Disassembly

1. Switch off the generator completely.
2. Remove the anode grounding brush, which is situated at the bottom of the water manifold.
3. Remove the water manifold supply section by unscrewing two screws. The tubes are removed.
4. Unscrew the inner stem retaining nut with the counterface seal key. This is a left-handed screw, so turn clockwise to unscrew.
5. Remove the water manifold return section by unscrewing two screws.
6. Remove the water manifold water seal section by unscrewing three screws.
7. The water seal can be taken out by pushing.

6.4.2 Assembly

1. Remount the water seal section and fasten the screws loosely.
2. Place the centring cylinder in place of the seal in the water seal section and fasten the screws. Align also by rotating the section till the sloping part is parallel to the part underneath.
3. Sparingly lubricate the outside O-ring of the seal with vacuum grease (delivered with the generator), but no grease should come out on the flat sides.
4. Place the guidance cone and mount the seal by hand. Don’t use tools.
5. Remount the return section. Align it with the section underneath so that the bottom, top, and sloping sides are exactly aligned.
6. Fit the inner stem retainer nut (left-handed) with a torque of 8 Nm. The torque wrench is delivered with the generator.

7. With a new anode, check if the anode rotates smoothly. If not, then dismount and place a shim on the anode shaft (between anode and ferrofluidic seal, two are delivered with new anodes).

8. Remount the supply section. Align it with the section underneath so that the bottom, top, and sloping sides are exactly aligned.

9. Remount the connector to the temperature measuring device and remount the anode grounding brush.

### 6.5 Shutter Replacement

1. Switch off the generator completely.

2. Remove all covers.

3. Remove the shutter with the three screws.

4. Disconnect the wires. The connector is in the half cubicle, under the X-ray tube. The colors and connection numbers are indicated nearby on a label. When removing the cable, attach a wire or string with which the new shutter cable can more easily be drawn through the tubes.

5. Mount in the reverse way.

6. After mounting, check the shutter present (safety) switches in the control panel: **View > Setup parameters**. When it shows “not fitted”, shift the shutter a little bit before tightening the screw, until the message disappears.

### 6.6 Anode Drive Belt Replacement

The anode drive belt should be replaced every year.

1. Remove the water manifold as explained in Section 6.4.

2. Remove the old belt.

3. Clean the pulleys with acetone.

4. Mount a new belt.

5. Adjust the tension of the V-belt by shifting the anode motor in the two slots. The tension is correct when the belt can be pushed down about one centimeter when applying a force of 0.5 kg near the motor. At insufficient tension, the belt will vibrate. Take care: with high tension the bearing of the motor and anode will wear out.

6. Remount the water manifold as explained in Section 6.4.
6.7 Anode Replacement

6.7.1 General

This replacement should only be attempted by skilled personnel, such as Bruker AXS Service Representatives or users who have attended a maintenance course.

Clean parts which are in vacuum should only be handled with lint-free, non-powdered gloves.

6.7.2 Rotor Plate Remounting

1. Go to the status POWER UP.
2. After high power, wait at least thirty minutes to cool down.
3. Go to Service > Ventilate to ventilate the tube. Because this action only opens the valve for 15 seconds, this should be done several times (approx. 10 times) until the vacuum is gone.
4. Switch off the generator completely.
5. Remove the anode speed sensor holder at the motor pulley.
6. Take the drive belt from the motor pulley.
7. Disconnect the water hoses from the water manifold and rotor plate.
8. Unscrew the three large screws fixing the rotor plate to the head, while holding the assembly in position.
9. Withdraw the assembly. First move it slightly in the direction of the motor, then pull it straight out. The anode should not get scratched on the way out. Place the assembly with the flat side of the anode on a clean flat surface.

6.7.3 Anode Disassembly

1. Place the anode in the anode retaining fixture.
2. Remove the water manifold as described in Section 6.4.1.
3. Unscrew the counter face seal with the counter face seal key and a 12 mm torque wrench.

Figure 6.8 – Anode mounting tools
4. Take off the pulley.
5. Pull out the rotor plate. Some force may be required here to overcome the friction of the O-ring in the bearing sleeve. Never use tools. If you don’t succeed, contact Bruker AXS Service.

### 6.7.4 Anode Cleaning

Cleaning of the anode has limited value (see Section 6.2). When desired, the anode may be cleaned with acetone and lint-free cloth. Extreme pollution can be removed with Scotchbrite 07447 or 07448. A convenient way is to polish the surface while it rotates in a lathe. Proper care should be taken to avoid scratches or damage to the shaft while it is clamped. After polishing, the anode must be washed with acetone.

### 6.7.5 Anode Remounting

1. Place the anode in its retaining fixture.
2. Carefully put the rotor plate assembly over the shaft, without an O-ring in the bearing sleeve, just to check if it fits. The anode should fit smoothly without any friction. Do not use force if there is friction.
3. Sparingly lubricate a new O-ring (part number 2132162) with vacuum grease, and put it into the groove in the bearing sleeve. Also, put a tiny bit of vacuum grease on the anode shaft.
4. Place the rotor plate assembly over the anode shaft while making sure that this shaft is absolutely straight in the bearing sleeve. There should be no force required until the O-ring is reached. A gentle tap on top of the rotor plate should be sufficient to overcome the friction, after which the rotor plate can be lowered to its proper position.
5. Insert sparingly lubricated O-rings (part numbers 2132162 and 2132163) into the pulley and bring the pulley into position on the anode shaft. Take care not to damage the O-rings while doing this.
6. Mount the counter face seal and tighten it with a torque of 18 Nm.
7. Remount the water manifold as described in Section 6.4.2.

### 6.7.6 Rotor Plate Mounting

1. Clean all parts with Scotchbrite 07447 or 07448 and clean afterwards with acetone. Leave sufficient time to dry.
2. Put a slightly lubricated new O-ring (part number 2132963) into the head.
3. Carefully insert the rotor plate assembly into the head.
4. Shift it a little in the direction of the cathode to the right position. Check that the O-ring is still properly positioned.
5. Fasten the rotor plate with its three screws.
6. Reattach the anode drive belt as in Section 6.6.
6.8 Ferrofluidic Seal Replacement

1. Remove the rotor plate assembly and anode as described in Section 6.7.

2. Remove the bearing plate and all shims from the rotor plate.

3. Place the puller in a vertical position on a flat table and put the empty cartridge and the rotor plate over the shaft. The empty cartridge is delivered with a new system and should be kept for returning the ferrofluidic seal.

4. Place the large bush and the pin.

5. Rotate the puller (hold the rotor plate by hand). The cartridge will be pushed out of the rotor plate into the container. At the end, the pin should be placed in a lower hole to pull out the ferrofluidic seal completely.

6. Check the rotor plate for burrs or damage. Make sure that the vacuum side is clean.

7. Put a tiny bit of vacuum grease on the inner surface of the rotor plate, but not in the water channels.

8. Take the cover from the new cartridge. There are two types of cartridges:
   8.1. With a protruding plug at the bottom. Push with this plug the ferrofluidic seal out a bit.
   8.2. Without the plug. During mounting, first place thin distance holders, like coins under the sides of the cartridge (take care: not under the ferrofluidic seal). Pull out the ferrofluidic seal a little bit. Remove the coins and proceed.
   The protruding part of the ferrofluidic seal is needed as a guide into the bore of the rotor plate.

9. Place the rotor plate and the new cartridge reverse on the puller and mount the small bush and pin.

10. If needed, pull out the ferrofluidic seal a bit as described above and remove the coins.
11. Pull the ferrofluidic seal completely into the rotor plate. At the end, the pin should be placed in a lower hole to pull in the ferrofluidic seal completely.

12. Remove the rotor plate from the puller and check that the cartridge is pulled in completely. There should be no space left between the bottom of the rotor plate and the first seal body.

13. Place the rotor plate back on the puller.

**CAUTION**

Never place the rotor plate on the table, otherwise there is a risk of damaging the ferrofluidic seal.

14. Measure the protrusion $D$ of the cartridge from the face of the rotor plate, using a Vernier caliper and determine the number of shims required. If $D$ is less than 0.10 mm and not zero then no shims are necessary. If $D$ is more than 0.10 mm then one shim has to be placed. If $D$ is more than 0.20 mm then two shims, and so on. Place the (clean) shims.

15. Place the bearing plate and clamp ring. Center the bearing plate on the clamp ring and tighten the bearing plate with three screws.

16. Remount the anode and rotor plate assembly as described in Section 6.7.

17. A ferrofluidic seal should be “run in” at standby speed for one hour.
6.9 Safety Tests

6.9.1 Shutter Safety

1. Switch off the X-ray high voltage.
2. Open the shutter. Check the “Shutter Open” lamps.
3. Check that the shutter will not open under these unsafe conditions:
   3.1. Radiation enclosure open (and Open beam key switch disabled).
   3.2. Radiation enclosure safety (Open beam) overridden with the key-switch under the table,
   Beam-open lamp removed and enclosure open.
4. Check the flashing “Open Beam” lamp when the radiation enclosure safety (Open beam) is
   overridden by the key-switch.

6.9.2 X-ray High Voltage Safety

1. Switch on the high voltage to minimum: 20 kV, 5 mA.
2. Check the “X-ray ON” lamps.
3. Check that the high voltage shuts off when:
   3.1. The tapered front cover is removed.
   3.2. The shutter lights cover is removed.
   3.3. The main shutter is manually opened with a small screw in the center of the shutter aperture.

⚠️ WARNING
Take care not to come into the vicinity of the primary beam!
This page intentionally left blank.
7 MICROSTAR Troubleshooting

7.1 Startup Errors

7.1.1 Generator Does Not Go To The Power Up Status (But No Error is Shown)
1. If the display does not light:
   1.1. Check the red safety push buttons on the side of the cabinet (below the table). They can be pressed by accident. Release them with the keys.
   1.2. Check the manual fuse (elca) on the electronic cabinet.
   1.3. Check the main power (installation fuses or switches)
   1.4. Open the electronic cabinet and inspect the two power supplies on the left. Both should have a green LED lit. If not, then this power supply is defective.
2. If the display works, but the Power on LED (yellow) is not on:
   2.1. Go to standby and see what error message appears.

7.1.2 Generator Does Not Go To The Standby Status (But No Error is Shown)
1. Check the status on the display:
   1.1. “Power up”: check in Setup > Management that the manager of “X-ray” is set to “Panel”.
   1.2. “Standby - Power up”: the generator was going back to the Power Up status (for instance, after an error) and will first finish this sequence before going to the Standby status again.
2. Check in the menu View > Operating parameters that the Oil circuit is “ready”. If not, contact Bruker AXS Service.
7.2 Low Vacuum

A normal vacuum is:

- $1 \times 10^{-7}$ to $9 \times 10^{-7}$ without power.
- below $9 \times 10^{-7}$ with medium power (for instance 3 kW)

A bad vacuum is mostly caused by leakage, which should be resolved by a Bruker AXS Service Representative. Please check:

1. Check that the pre-vacuum pump is really running.

2. Switch to standby (low 600 rpm anode speed and no HV). When vacuum is bad, it is probably a leaking O-ring. Because it is difficult to find which O-ring, we advise a maintenance visit. In most cases it is the cathode O-ring. Take into account that with every remounting of the cathode a new O-ring must be fitted.

3. Adjust the anode speed to 5500 (will show 6000) but with HV off. If the vacuum is too low or not stable, the ferrofluidic seal is probably worn out. Take into account that the ferrofluidic seal has a limited lifespan of about a year.

4. Switch on the HV, first with lower power, then with high power.
   4.1. If a 13-16 (Vacuum alarm) occurs directly after HV on (before HV or mA are rising), then check the error history with the service program (to see if there are other errors preceding the vacuum alarm).
   4.2. If the vacuum decreases greatly with high power then:
      a. The tube is polluted.
      b. Mineral deposits inside the anode have not been removed for some time. This can only be done in the factory during refurbishment.
      c. Incorrect procedure of cleaning the surface of the anode, causing outgassing from pollution pressed into the anode material.
      d. Be sure that you have not changed anything in the cooling water circuit (e.g., wrong connection of the cooling tubes).
7.3  Shutter Does Not Open

(sometimes error 13-08)

1. If the HV remains on, it is a problem with safety or setup:

2. Look at the shutter status in the control panel: View > Setup parameters.
   2.1. "Absent": The "shutter present" switch is not activated. Switch off the X-rays. Ask an experienced mechanical engineer to loosen the shutter (screws) a bit and rotate the shutter housing till the "Absent" sign disappears. If this does not help, the shutter has to be returned for repair.
   2.2. "Key-switch": The shutter key switch under the table is disabled. Switch to the enabled position (key horizontal).
   2.3. "Interlock": One of the shutter safeties is active:

   The door is not closed. Test by switching the “Open beam” key switch under the table, so the “Open beam” lamp flashes. If the shutter can now be opened, the enclosure was not closed (detected by safety switches in the doors).

   When using with Open beam: the “Open beam” lamp should flash. If not, replace the lamp.
   Check the goniometer safeties: Kappa CCD, MACH3, or CAD4.

   Check if the goniometer detecting switch (hover safety) is in the correct position (if present). This magnet/reed switch is mounted close to the X-ray port /monochromator to detect that the goniometer is placed in front of the X-ray port.

   2.4. "Error": An 13-08 error has occurred.

   Check the shutter setup (also when generating X-rays) in the control panel: Shutter opened from goniometer Shutter opened from Control panel

**Setup > Management** shutters are set to “No management” or “RS232”, shutters are set to “panel”.

**Setup > Shutters** shutters are set to “GCU enabled”, shutters are set to “GCU disabled”

When normally opened by the goniometer (setting on a board) and HV = on, then the shutter must also be opened by the goniometer (for the goniometer shutter safeties)

Check that the X-ray port bayonet coupling (if present) is properly positioned. The mechanical safety slot inside the shutter can prevent opening.

In the service program, State bit = 1 and after HV on:

Sequence error:

Open the shutter by hand or:

Press the shutter open switch two times very quickly.

Now the State bit = 0 and the shutter will work till next power down/up. This error can occur now and then is caused by timing error/bug

State bit = 1 directly after HV on

Check ST23/24 on the Tube controller board: When the new shutter PALs are mounted (TUBE1CA, TUBE1CB, TUBE3CA and TUBE3CB, PCN24) and when Nonius equipment is used then ST23/24 must be open.
7.4 Error Codes on the Operator Panel

Selection of errors from the operator panel. For other error messages, contact Bruker AXS Service.

12-40 NOT STANDBY FOR HV
Not ready to generate HV (Generator is not in Standby status).

12-41 kV NOT RECHARGED
Action taken, for instance HV ON, when the kV wasn’t fully discharged after the HV OFF. Wait some seconds and repeat.

12-43 BAD VACUUM RECRYST
Starting recrystallization when the vacuum is too low. Wait till the vacuum is high and the recrystallization will continue automatically.

12-44 AUTOMATIC FUSE AUX (Microstar)
The automatic fuse of the auxiliary unit (with pumps etc.) is off

13-01 LOOSE HT CABLE END
The “HT cable present” connector on the tube is not placed.

13-02 LOOSE TUBE COVERS
The white tube cover with the red lights is not in place, detected by a reed switch with magnet in the cover.

13-03 LOOSE TUBE SHIELD
The connector of the tube shield is not placed, indicating that the metal tube around the cathode of the X-ray tube is not in place.

13-07 TEMP ALARM COOLWATER
The temperature of the cooling water at the secondary output of the heat exchanger is too high. Check the input water flow and the temperature. The temperature is shown in View > Operating parameters.

After restoring the cooling, the temperature of the secondary water can still be too high preventing the water pump to start. It has to cool down on its own, which can take some time. It is possible to start the water pump with a service command. Use this command only when needed, because incorrect use can start other parts without safety.

Get service management.

Go to Service > IO and choose Write and Tube controller.
Write (indifferent data) to address FF6B. The water pump will start.

Be careful: the pump is now running without any safety, so after cooling down start again from power down.

13-08 SHUTTER FAIL
One of the shutters doesn’t open, doesn’t close, or the safety shutter fitted switch is not activated.
If the error is permanent, one can track it by reading the status in **Service > Read > Tube-cntr**:

Address FF5A, data: the last digit should be F ($...F). If not, the “shutter present” switch is not pressed. You could try to loosen the three screws of the shutter a little bit and shift the shutter until the last digit is F again. If you don’t succeed the shutter must be readjusted by Bruker AXS Service.

If the last digit = E, then the error is in shutter 1.

If the last digit = B, then the error is in shutter 3.

Address FF50 and FF54, data: the first digit should be 4 ($4..). If it is E or 6, the shutter is not fully closed. You can close it with the screw in the center of the shutter rotation.

If it is address FF50 = then the error is in shutter 1.

If it is address FF54 = then the error is in shutter 3.

After restoring the error, sometimes the generator must be powered down/up to reset the error message.

**13-0B ANODE DRIVE OVERRUN (FR591) or ANODE DRIVE CURRENT (MICROSTAR)**

Start again and go in smaller steps to the kV/mA power.

**13-12 LEVEL ALARM WATER**

Cooling water level in the vessel is too low. Refill the vessel with demineralized water (**Observe electrical safety precautions!**)

**13-13 FLOW ALARM TUBE**

No water flow through the anode. Causes:

Water pump doesn’t run.

Check if the water hoses for kinks.

During start after the water was filled: not enough water yet. Ask Bruker AXS Service for instructions to start the water pump and leave it running for at least 15 minutes, until the water flow doesn’t switch off. Start again in the normal way.

**13-16 VACUUM ALARM**

Check the low vacuum list.

**13-43, 56 TURBO SPEED FAILS or TURBO PUMP TIMED OUT**

Turbopump speed too low or turbopump did not reach the right speed after 4 minutes.

After several years of operating, the turbopump bearings can be are worn. A Bruker AXS Service Representative can check this by inspecting the grease cartridge. It is advised to refurbish the turbopump, which is not expensive. One can choose to do this through the local Balzers/Pfeiffer representative.

**14-03 TEMP ALARM HEATSINK1**

The heat sink is located in the power module, situated to the left of the HV tank. This is cooled by two thin brown tubes.
Check that the primary water pressure is above 2 bar. This error is often a symptom of insufficient water pressure.

Check the input and output water cooling connections on the power module. Both must be cold. When the output is warm, you can try to disconnect and clean them by flowing water through the power module in two directions.

14-0A LEVEL ALARM HV TANK
The oil level in the HV tank is too low. Check if there is oil leakage on the floor.

14-0D XRAYS DISABLED
Trying to generate X-rays while the “X-ray” key switch is in the disabled position.

14-0E XRAYS LAMP FAILS
Both red "X-ray ON" lamps are defective.

14-42 FILAMENT SET FAILS
This can be caused by:
- Low tube current. The tube current should not be too low: at least 10 mA.
- Broken filament. When the generator is switched off and on, it should come with a broken filament message.
- Many trips rapidly after each other.
- Sudden manual change from bias high to low.

14-4B GATE DRIVE FAULT
For a 9 kW generator: Go to **Setup > Generator** and check if it is set up for module 1. If not, change to that.

Check if the manual fuse 9kW1 (module 1) is on. If it switches off again, there is a technical problem and Bruker AXS Service must be contacted.

The check circuit can be temporary switched off through the Control panel: **Service > Modify > Write**: Gen-ctrl, RAM, address 1B7B, data 07. First, get service management. Do this only after instructed by Bruker AXS Service. If this does not help, the electronics are defective.

14-4C FILAMENT CHECK FAILS
Filament current too low; most probably a broken filament.

14-55 AUTO
The Stotz switch of a 9 kW module is switched off. Switch it on again.

14-56 SHORT
A short circuit between the filament and the bias cup. The filament has to be replaced. If it is caused by a rotation of the filament, then check with the next filament that it does not change during fastening (see Section 6.3).
7.5 Internal Error: Input Buffer Overrun

This error is a communication error on the digital bus and is typically caused by an electrical disturbance. This can be:

Strong HV trips. In time the generator head gets polluted and the trips get more severe, until they disturb the electronics. A maintenance visit is then necessary.

7.6 Communication Problem with Computer or Goniometer

Check if the RS232 communication parameters are right with: Service > Read > node: Main-ctl, address $81C6 and $81CA

|$81C6 | $ 0 | not used (hand shake) |
|$81C7 | $ 4 | 1200 bd, for 9600 bd: $ 25 |
|$81C8 | $B0 | 1200 bd, for 9600 bd: $ 80 |
|$81C9 | $ 8 | databits |
|$81CA | $ 1 | stopbit |
|$81CB | $ 0 | parity = none |

If the values above are not set up (all different values), the software will automatically choose 9600 baud.

Don’t look at the view menu, because the RS232 parameters shown are not correct.

7.7 No mA

Open the tube and check that the filament does not touch the focus cup.

7.8 Service Program

A service program is available which reads the internal registers and values for troubleshooting the system.

Retrieve the self-extractable program and start the file, which will install the program.

Connect the PC with a RS232 null modem cable with the RS232 connector.
8 Declaration of Conformity

Name of manufacturer: Bruker AXS BV
Oostsingel 209
2612 HL Delft
The Netherlands

Declaration of Conformity
EMC directive - 89/336/EEC
Low voltage directive – 72/23/EEC; 93/68/EEC

The Microstar Rotating anode generator systems together with its associated equipment marked with the CE conformity marking, comply with the provisions of the following harmonized standards:

EN 50081-2 Generic Emission Standard
EN 50082-2 Generic Immunity Standard
EN61010-1 Safety requirements for electrical equipment for measurement, control and laboratory use

The declaration includes all types listed below:

Microstar bench models 2¼ cubicles
Microstar bench models 3¼ cubicles
Microstar model with integral radiation safety enclosure 2¼ cubicles
Microstar model with integral radiation safety enclosure 3¼ cubicles

Attested by
Bruker AXS BV
Delft, 8 May 2006

Dr. R.W.W. Hooft
R&D
Name, function
Signature

Dr. E. Hoestreyd
director
Name, function
Signature
9 Certificate of Radiation Safety

CERTIFICATE OF RADIATION SAFETY

Name of manufacturer: Bruker AXS BV
Oostsingel 209
2612 HL Delft
The Netherlands

Product name: FR591, Microstar Rotating Anode Generators
Product type: 15919--, all bench models and all models with integral radiation safety enclosure
15929--, all bench models and all models with integral radiation safety enclosure

The designated products conform to the instructions and standards:

- EN 61010-1 IEC:2001 Safety requirements for electrical equipment for measurement, control and laboratory use
- Testing: Each system is subject to a radiation safety test in our production facilities

Attested by
Bruker AXS BV
Delft, 8 May 2006

Dr. R.W.W. Hooft
R&D

Dr. E. Hovestreydt
director
This page intentionally left blank.
10 Certificate of PCB-Free HV Tank Oil

CERTIFICATE

Name of manufacturer: Bruker AXS BV  
Oostsingel 209  
2612 HL Delft  
The Netherlands

Herewith we declare that Bruker AXS, Bruker Nonius and former Nonius equipment with the following equipment numbers contains a high voltage tank with PCB free Shell Diala oil.

<table>
<thead>
<tr>
<th>Microstar</th>
<th>FR591</th>
<th>GX21</th>
<th>FR586</th>
<th>FR601</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FR590</td>
<td>GX13</td>
<td>FR585</td>
<td>FR612</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FR584</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FR583</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FR582</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FR581</td>
<td></td>
</tr>
</tbody>
</table>

Bruker AXS

Attested by

Bruker AXS BV  
Delft, 8 May 2006

Dr. R.W.W. Hooft  
R&D  
Name, function  
Signature

Dr. E. Hovestreydt  
director  
Name, function  
Signature
This page intentionally left blank.
11 Spare Parts List

11.1 Cathode and Focus

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0592390</td>
<td>Cathode</td>
</tr>
<tr>
<td>0592841</td>
<td>Fine focus filament set (3x) including mounting parts</td>
</tr>
<tr>
<td>0191197</td>
<td>Filament clamp segment</td>
</tr>
<tr>
<td>0592016</td>
<td>Focus cup</td>
</tr>
<tr>
<td>0571701</td>
<td>Fine focus mounting assembly, excluding focus cup</td>
</tr>
<tr>
<td>0191191</td>
<td>Filament mounting sleeve</td>
</tr>
<tr>
<td>0191192</td>
<td>Height adjusting nut for fine focus</td>
</tr>
<tr>
<td>0191193</td>
<td>Locking ring for a fine focus cup</td>
</tr>
<tr>
<td>0571105</td>
<td>Mounting tube for fine focus</td>
</tr>
<tr>
<td>6050029</td>
<td>Set screws for Cup to mounting tube, M3x3 Qty. 4</td>
</tr>
</tbody>
</table>

Table 11.1 – Cathode and Focus
11.2 Anode, Rotor Plate, and Drive

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cu anode</td>
<td>Cu-anode High-Brilliance Anode (HBA) for MICROSTAR</td>
</tr>
<tr>
<td>0592372</td>
<td>6077018 Shim in anode, 25 x 18 x 0.1 mm</td>
</tr>
<tr>
<td>0592201</td>
<td>0592355 Complete rotor plate assembly + HBA Cu anode</td>
</tr>
<tr>
<td>0592355</td>
<td>Ferrofluidic seal for MICROSTAR</td>
</tr>
<tr>
<td>2985158</td>
<td>Shim 61.0 x 0.1 on ferrofluidic seal</td>
</tr>
<tr>
<td>2134044</td>
<td>Water seal in water manifold (Furon seal)</td>
</tr>
<tr>
<td>0168374</td>
<td>Counterface water seal, on the anode axis</td>
</tr>
<tr>
<td>0592302</td>
<td>Anode motor unit</td>
</tr>
<tr>
<td>2033114</td>
<td>V-belt (1120 mm)</td>
</tr>
<tr>
<td>0571351</td>
<td>Pulley which guides the V-belt (for replacement two are needed)</td>
</tr>
<tr>
<td>0168375</td>
<td>Pulley on the anode shaft</td>
</tr>
<tr>
<td>0164656</td>
<td>Labyrinth ring under the anode drive pulley</td>
</tr>
<tr>
<td>2692023</td>
<td>Brush: anode grounding in water manifold</td>
</tr>
</tbody>
</table>

Table 11.2 – Anode, Rotor Plate, and Drive
11.3  Vacuum

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2995813</td>
<td>Diaphragm roughing pump, Pfeiffer MD 4T or MVP 055-3</td>
</tr>
<tr>
<td>2995815</td>
<td>Diaphragm set for 2995813, PK050117-T (4 double-diaphragms; O-rings: 4 large, 8 small; 6 seals FPM, 2 seals PTFE for in/output)</td>
</tr>
<tr>
<td>2995810</td>
<td>Turbo-drag pump Pfeiffer TMH 261, used with diaphragm prevacuum pump</td>
</tr>
<tr>
<td>2995811</td>
<td>Power supply TPS200</td>
</tr>
<tr>
<td>2140987</td>
<td>Clamp</td>
</tr>
<tr>
<td>2140988</td>
<td>Splinter shield</td>
</tr>
<tr>
<td>2140073</td>
<td>Grease cartridge</td>
</tr>
<tr>
<td>2995540</td>
<td>Vacuum gauge PKR251. Pfeiffer</td>
</tr>
<tr>
<td>2136100</td>
<td>Air filter in ventilate valve</td>
</tr>
</tbody>
</table>

Table 11.3 – Vacuum

11.4  HV circuit

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2570189</td>
<td>HV cable, 5.6m (standard, with two large connectors)</td>
</tr>
<tr>
<td>4010071</td>
<td>Silicone oil + washer for the HV connectors</td>
</tr>
<tr>
<td>0591320</td>
<td>HV tank</td>
</tr>
<tr>
<td>4080003</td>
<td>Transformer oil, Shell Diala D</td>
</tr>
</tbody>
</table>

Table 11.4 – HV Circuit

11.5  Shutter

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0591114</td>
<td>Shutter</td>
</tr>
<tr>
<td>0591114R</td>
<td>Shutter, refurbished</td>
</tr>
<tr>
<td>0164227</td>
<td>Shutter dummy bayonet (closed beam)</td>
</tr>
<tr>
<td>0163090</td>
<td>Shutter unlocking bayonet (open beam)</td>
</tr>
</tbody>
</table>

Table 11.5 – Shutter
11.6 Cooling

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2140054</td>
<td>Water pump + motor 50 Hz. Grundfos CRI 1-5 (can also be used for former CNR2-40)</td>
</tr>
<tr>
<td>2140055</td>
<td>Water pump + motor 60 Hz. Grundfos CRI 1-5 (can also be used for former CNR2-40)</td>
</tr>
<tr>
<td>2140050</td>
<td>Motor 50 Hz for pump 2140052</td>
</tr>
<tr>
<td>2140051</td>
<td>Motor 60 Hz for pump 2140052</td>
</tr>
<tr>
<td>2140052</td>
<td>Water pump without motor, see 2140050/1 Grundfos CRI 1-5</td>
</tr>
<tr>
<td>2657056</td>
<td>Control valve FJVA in primary water, Danfoss</td>
</tr>
<tr>
<td>2995907</td>
<td>Flow switch (water or oil). Need no adjustment</td>
</tr>
<tr>
<td>2136102</td>
<td>Flow switch, type VHS 20M (Aux. trolley)</td>
</tr>
<tr>
<td>2657311</td>
<td>Temperature (clixon) switch for 9kW module heatsink (56°C)</td>
</tr>
<tr>
<td>2140063</td>
<td>Oil pump for both 50/60 Hz</td>
</tr>
<tr>
<td>2682038</td>
<td>Fan, all except in enclosure and bench</td>
</tr>
<tr>
<td>0591126</td>
<td>Fan for enclosure and bench</td>
</tr>
</tbody>
</table>

Table 11.6 – Cooling

11.7 Power

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2625087</td>
<td>Power relay in 9 kW module, including power contacts</td>
</tr>
<tr>
<td>2625237</td>
<td>Main relay (in 9 kW module) top-contact block for sense signals</td>
</tr>
<tr>
<td>2681054</td>
<td>Power supply +24V +12V (upper supply, HSU100-21, made from 2x 12V) [front plate should be shortened or exchanged with older supply]</td>
</tr>
<tr>
<td>2681055</td>
<td>Power supply +5V +15V (lower supply, HSU100-31) [front plate should be shortened or exchanged with older supply]</td>
</tr>
</tbody>
</table>

Table 11.7 – Power
11.8 Units

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0591400T</td>
<td>Complete 9 kW HV-ELCA unit</td>
</tr>
</tbody>
</table>

Table 11.8 – Units

11.9 Boards

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0591610T</td>
<td>Main controller board. For HBA anode order also EPROM...</td>
</tr>
<tr>
<td>0592611T</td>
<td>Tube controller board for MICROSTAR</td>
</tr>
<tr>
<td>0592612T</td>
<td>Generator controller board for MICROSTAR</td>
</tr>
<tr>
<td>0591619T</td>
<td>Anode drive board for new Papst motor</td>
</tr>
<tr>
<td>0591615T</td>
<td>Filament &amp; bias board</td>
</tr>
<tr>
<td>0591616T</td>
<td>Shutter board</td>
</tr>
<tr>
<td>0591617T</td>
<td>Trafo board</td>
</tr>
<tr>
<td>0591620T</td>
<td>Measurement board</td>
</tr>
<tr>
<td>0591621T</td>
<td>Multiplier board</td>
</tr>
<tr>
<td>0591622T</td>
<td>Resistor board</td>
</tr>
<tr>
<td>0591623T</td>
<td>Filament-rectifier board</td>
</tr>
<tr>
<td>0591630T</td>
<td>Bridge board</td>
</tr>
<tr>
<td>0591631T</td>
<td>Power interface board</td>
</tr>
</tbody>
</table>

Table 11.9 – Boards
### 11.10 Electronic Parts

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2518920</td>
<td>RAM with battery on the Main controller board 0591610T, IC 21 (for clock)</td>
</tr>
<tr>
<td>2561930</td>
<td>Thyristor (3x in 9 kW module)</td>
</tr>
<tr>
<td>2620796</td>
<td>Relay with LED in Power module (behind manual fuses)</td>
</tr>
<tr>
<td>2655172</td>
<td>Fuse 500 mA slow</td>
</tr>
</tbody>
</table>

Table 11.10 – Electronic Parts

### 11.11 Lamps

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2603235</td>
<td>Open beam lamp 12V</td>
</tr>
</tbody>
</table>

Table 11.11 – Lamps
## 11.12 O-rings

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2132162</td>
<td>2x O-ring 17.10 × 1.60, for anode pulley and shaft</td>
</tr>
<tr>
<td>2132163</td>
<td>O-ring 19.10 × 1.60, for pulley face seal</td>
</tr>
<tr>
<td>2132252</td>
<td>O-ring 28 × 5.3</td>
</tr>
<tr>
<td>2132254</td>
<td>O-ring 29.10 × 1.60</td>
</tr>
<tr>
<td>2132255</td>
<td>O-ring 22.10 × 1.60</td>
</tr>
<tr>
<td>2132310</td>
<td>O-ring 31.42 × 2.62, for water manifold, HPA</td>
</tr>
<tr>
<td>2132429</td>
<td>O-ring 37.77 × 2.62, for water manifold</td>
</tr>
<tr>
<td>2132431</td>
<td>O-ring 47.00 × 5.34, for cathode</td>
</tr>
<tr>
<td>2132528</td>
<td>O-ring 56.82 × 2.62, between measuring flange and head</td>
</tr>
<tr>
<td>2132529</td>
<td>O-ring 58.42 × 2.62, for recoil shield</td>
</tr>
<tr>
<td>2132634</td>
<td>O-ring 66.35 × 2.62, for recoil shield front</td>
</tr>
<tr>
<td>2132635</td>
<td>O-ring 69.57 × 1.78</td>
</tr>
<tr>
<td>2132721</td>
<td>O-ring 78.97 × 3.53</td>
</tr>
<tr>
<td>2132963</td>
<td>O-ring 94.97 × 1.78, between rotor plate and head</td>
</tr>
<tr>
<td>2132965</td>
<td>O-ring 107.20 × 5.34, between flange and turbo pump</td>
</tr>
<tr>
<td>4000014</td>
<td>High vacuum grease, for O-rings</td>
</tr>
</tbody>
</table>

Table 11.12 – O-rings
### 11.13 Tools

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0163629</td>
<td>Tool for disconnecting the HV connector</td>
</tr>
<tr>
<td>0164091</td>
<td>Recoil shield adapter disk</td>
</tr>
<tr>
<td>0164092</td>
<td>Puller extender disk for recoil shield</td>
</tr>
<tr>
<td>0164118</td>
<td>Locking ring key for focus</td>
</tr>
<tr>
<td>0164124</td>
<td>Water seal press for water manifold</td>
</tr>
<tr>
<td>0164656</td>
<td>Ferrofluidic seal clamp ring</td>
</tr>
<tr>
<td>0168385</td>
<td>Counterface seal key</td>
</tr>
<tr>
<td>0168124</td>
<td>Cathode shorting key</td>
</tr>
<tr>
<td>0168383</td>
<td>Water seal guidance cone</td>
</tr>
<tr>
<td>0168384</td>
<td>Water seal centering cylinder</td>
</tr>
<tr>
<td>0591844</td>
<td>Anode retaining fixture</td>
</tr>
<tr>
<td>0571326</td>
<td>Pin hole</td>
</tr>
<tr>
<td>0571328</td>
<td>Pin hole puller</td>
</tr>
<tr>
<td>0571329</td>
<td>Seal puller</td>
</tr>
<tr>
<td>0571346</td>
<td>Filament height setting jig, for fine focus</td>
</tr>
<tr>
<td>0571451</td>
<td>Depth gauge 0.1 × 1</td>
</tr>
<tr>
<td>2995720</td>
<td>Torque wrench 8-54 Nm</td>
</tr>
<tr>
<td>2995725</td>
<td>12 mm part for Torque wrench</td>
</tr>
<tr>
<td>0591404</td>
<td>Xyclops CCD video camera, including box with parts</td>
</tr>
</tbody>
</table>

Table 11.13 – Tools

### 11.14 Maintenance Sets

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1592100</td>
<td>Set for yearly maintenance, MICROSTAR / MICROSTAR-H</td>
</tr>
</tbody>
</table>

Table 11.14 – Maintenance Sets
## 11.15 Other

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2601475</td>
<td>Enclosure safety override key switch</td>
</tr>
<tr>
<td>2547089</td>
<td>Track ball</td>
</tr>
<tr>
<td>2590334</td>
<td>Faston receptacle 2.8 × 0.8</td>
</tr>
<tr>
<td>0591826</td>
<td>RS232 extension cable Elca module (no null modem)</td>
</tr>
<tr>
<td>2995190</td>
<td>Mirror vacuum pump membrane</td>
</tr>
<tr>
<td>2625000</td>
<td>Magnet switch for enclosure and covers</td>
</tr>
</tbody>
</table>

Table 11.15 – Other
This page intentionally left blank.
### Index

#### A
- **Absent** 7-3
- **Anode** 2-4, 3-1
  - Cleaning 6-10
  - Disassembly 6-9
  - Drive Belt Replacement 6-8
  - Replacement 6-9
  - speed 4-6
- **Auxiliary Trolley** 3-3

#### B
- **Battery disposal** 2-6
- **Beam stop blocks** 2-1
- **Bench** 3-4
- **Beryllium** 2-6
- **Bruker AXS** 5-3
  - preventative maintenance 6-1

#### C
- **Cathode**
  - cleaning 6-2
  - Mounting 6-5
- **Cathode Cup** 3-1, 6-4
- **Cautions** 1-3
- **CE Declaration of Conformity** 8-1
- **Certificate of Radiation Safety** 9-1, 10-1
- **Communication Problems** 7-7
- **Condensation** 3-3
- **Conditioning** 4-6, 5-1, 5-3
- **Cryogenics** 2-6
- **Cubicle** 3-1

#### D
- **Diagnose Menu** 4-9
- **Diagnostic Tool** 4-16
- **Display** 4-2
- **Documentation Conventions**
  - Notes 1-3

#### E
- **ELCA module** 3-3
- **Emergency Switch** 2-2
- **Enclosure** 2-2, 2-3, 3-4
- **Error Codes** 7-4
- **Error Logs** 4-9
- **Errors**
  - definition 4-19
  - startup 7-1
- **External X-ray ON lamp** 2-3

#### F
- **Faults**
  - definition 4-19
- **Ferrofluidic Seal** 3-1, 3-6
  - replacement 6-11
  - risk of damaging 6-12
- **Filament** 3-6
  - optimum lifespan 5-2
  - Replacement 6-2

#### G
- **Generator**
  - external isolator 2-2
- **Gloves for filament replacement** 6-2
- **Greek and Roman Text** 1-2

#### H
- **Heat** 3-1
- **Heat Sink** 7-5
- **height adjustment nut** 6-4
- **High Voltage**
  - interlock problems 2-3
  - high-voltage tank 3-3

#### I
- **Input Buffer Overrun** 7-7
- **Interlock** 7-3
**K**

**Key**

- Open Beam 2-1, 2-2
- Power 2-4
- Shutter Enable 2-4

**L**

**Lamp**

- Open Beam 2-4

**Liquid Nitrogen**

2-6

**M**

**Mains supply** 2-6

**Maintenance** 6-1

**Management** 4-8

**overview** 4-4

**MICROSTAR / Warning Window** 4-18

**MONTEL** 3-2

**N**

**No mA** 7-7

**O**

**Objects** 4-4

**Oil**

- in High Voltage tank 2-6

**Oil pump** 3-3

**Operate Menu** 4-6

**Operation Parameters** 4-13

**Operator Panel** 3-5

**O-rings** 6-7

**P**

**Parts** 11-1

**PCB precautions** 2-6

**Power Failure** 5-2

**Preferences** 4-8

**Preferent Bias** 6-6

**Preventative Maintenance** 6-1

**Primary Status** 4-13

**Proximity Switches** 2-3

**R**

**Radiation Safety Officer** 2-1, 2-4

**Recoil Shield** 3-6

**Recrystallize** 4-6, 5-1, 6-6

**Rotating Anode** 3-1

**Rotor Plate** 6-9, 6-10

**RS232** 4-5, 4-13, 5-3

**S**

**Safety** 2-1

- Beam stop blocks 2-1

- Electrical 2-6

- safety rooms 2-1

- Safety Interlock Panel 2-5

- Safety issues 1-4

- Safety Tests 6-13

**Service Menu** 4-11

**Setup Menu** 4-7

**Setup Parameters** 4-13

**Shutter**

- Bayonet interlock 2-4

- Does Not Open 7-3

- interlock problems 2-3

- locations in cubicle 3-2

- Replacement 6-8

- Safety test 6-13

- shutter 1vs. 3 2-4

- Shutter Control 4-7

**Shutter Display Windows** 4-21

**Soft Buttons** 4-2

**Spare Parts** 11-1

**Startup procedure** 5-1

**Status Window** 4-15

**Stdby** 4-2

**Super Managers** 4-5

**T**

**Technical Support** 6-1

**Temperature**

- optimum values 4-14

**Toolbox** 3-1

**Trackball** 4-2

**Trips** 4-9

**Trolleys** 3-1

**Troubleshooting** 7-1

**Tube Cover** 2-4

**Turbomolecular Pump** 3-1

**Tweezers for filament replacement** 6-2

**V**

**Vacuum**

- poor 7-5

- roughing pump 7-2

**Vacuum grease** 6-11

**Ventilate** 4-12, 6-3, 6-9

**View Menu** 4-13

**W**

**Warnings** 1-3
<table>
<thead>
<tr>
<th>Water</th>
<th>3-3, 7-5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water Level Indicator</td>
<td>4-17</td>
</tr>
<tr>
<td>Water Seal Replacement</td>
<td>6-7</td>
</tr>
<tr>
<td>Wavelength</td>
<td>3-1</td>
</tr>
</tbody>
</table>

**X**

<table>
<thead>
<tr>
<th>X-ray</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety test</td>
<td>6-13</td>
</tr>
<tr>
<td>X-ray Control Window</td>
<td>4-20</td>
</tr>
<tr>
<td>X-ray ON indicator</td>
<td>2-3</td>
</tr>
<tr>
<td>X-ray safety issues</td>
<td>1-4</td>
</tr>
</tbody>
</table>
This page intentionally left blank.